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About this book

This book explains how to plan and prepare for the installation of IBM®
WebSphere® Message Broker Version 6.1.

This edition of the book is specific to components at the following levels, and
to all subsequent releases and modifications unless otherwise stated:

* Runtime components Version 6.1.0.2
* Message Broker Toolkit Version 6.1.0.2

WebSphere Message Broker is supported on the following operating systems:
* IBM AIX”

* HP-UX (Integrity platform)

« HP-UX (PA-RISC platform)

« Linux® (POWER" platform) for iSeries™ and pSeries®
* Linux (x86 platform)

* Linux (x86-64 platform)

* Linux (zSeries® platform)

* Sun Solaris Operating Environment (SPARC platform)
* Sun Solaris Operating Environment (x86-64 platform)
* Microsoft® Windows® XP and Windows 2003

* IBM z/0S"

If you are installing WebSphere Message Broker for z/OS, use this book to
plan your installation, and use the Program Directory for WebSphere Message
Broker for z/OS for preparation and installation tasks.

If you are installing WebSphere Message Broker on other systems, use this
book to plan your installation and to prepare your computers before you
install this product. Follow the instructions provided to complete an initial
installation, or to upgrade an existing installation. If you have installed all
components on a single computer, this book tells you how to verify that your
installation is successful.

If you have ordered WebSphere Message Broker with Rules and Formatter
Extension for z/OS, use the Program Directory for WebSphere Message Broker
with Rules and Formatter for z/OS to install both broker and broker runtime
component extensions. On other systems, use this book to install WebSphere
Message Broker components, then insert the appropriate Rules and Formatter
Extension CD for your operating system. The Design-time Extension CDs
provide extensions to the toolkit, the Run-time Extension CDs provide
extensions to the broker runtime components.

© Copyright IBM Corp. 2005, 2008 ix



About this book

For further information specific to the Rules and Formatter Extension, see the
documentation on the supplied Rules and Formatter Extension CD, or access
the V6.1\Rules and Formatter directory on the [documentation FTP sitel at:

ftp://ftp.software.ibm.com/software/integration/wbibrokers/docs

The information center is the primary source of documentation for this
product, and covers all post-installation configuration and customization tasks
on all operating system, and details about how to install optional software,
and how to remove the product. This book describes only how to install the
product components onto your computers, although instructions are provided,
in exceptional circumstances, for applying service, if actions are required
beyond those provided in the information center.

After you have installed the required components on one or more operating
systems, see the information center for instructions about tasks that are not
included in this book. You can access the information center in the Message
Broker Toolkit when you have installed that component, or you can access it
from other locations before installation. See [“Where to find more information”|

for details of the options that are available.

This book is divided into four parts:
 [Part 1, “Planning,” on page 1|

e |Part 2, “Preparation,” on page 55|
 [Part 3, “Installation,” on page 83|

+ [Part 4, “After installation,” on page 117

Appendixes provide further support and reference information.

Who this book is for

This book is for system administrators of computers on which WebSphere
Message Broker components are installed.

What you need to know to understand this book

To understand this book, you must be familiar with the facilities of your
operating system, for example accessing CDs and setting up security.

Terms used in this book

The term HP-UX refers to HP-UX (Integrity platform) and HP-UX (PA-RISC
platform) where their behavior is common.

The term Linux refers to Linux (POWER platform), Linux (x86 platform),
Linux (x86-64 platform), and Linux (zSeries platform) where their behavior is

common.
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Terms used in this book

The term Solaris refers to Solaris (SPARC platform) and Solaris (x86-64
platform) where their behavior is common.

The term UNIX® refers to the operating systems AIX, HP-UX, and Solaris
where their behavior is common.

All references in this book to Windows are applicable to Windows XP and
Windows 2003 unless otherwise stated.

The term distributed system refers to Windows, Linux, and UNIX systems
where their behavior is common.

The term installer refers to the installation wizard (its name is not the same on
every operating system). On some systems, you might have to invoke the
wizard with more than just its name; for example, on Linux (zSeries
platform), you must enter ./ before the wizard name.

The term install_dir refers to the directory in which you install the product.
For the Message Broker Toolkit, this directory refers to the package group
installation directory. Default locations are described in

[“Coexistence and migration,” on page 27|

The term working directory refers to a directory on a distributed system that is
associated with the current user logon ID. It contains product-related files.

DB2® and DB2 Enterprise Server refer to IBM DB2 Universal Database™
Enterprise Server Edition and IBM DB2 Restricted Enterprise Server Edition.
WebSphere Message Broker includes DB2 Restricted Enterprise Server Edition
Version 9.1 with tailored terms and conditions on all distributed systems. This
database edition is functionally identical to DB2 Enterprise Server and no
distinction is made in this book. However, if you install the restricted edition,
you must register yvour license; this task is described in
[“Registering your DB2 license,” on page 141

Other editions of DB2 that are stated to be suitable for production deployment
are also supported (for example, Workgroup Server Edition).

Derby refers to the database product based on the Apache Derby open source
project from the Apache Software Foundation. Derby database support is
embedded in the broker component on Windows only. See [“Databases” on|

for further information about Derby.
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Terms used in this book

Product terms that are introduced in this book are defined in the
[ferms and abbreviations” on page 147 For a full product glossary, see the
information center.

For information about terms and abbreviations that are not specific to this
product, see the [[BM Terminology Web site]

www. ibm.com/software/globalization/terminology/

Where to find more information

xii

This book contains only installation information. Most of the information that
you need to use this product is in the information center, which you can
access after installation from the Help > Help Contents menu in the Message
Broker Toolkit.

You can access the information center before and after installation from these
additional locations:

* The Quick Start CD that is included in the product package.

The information center is provided for Linux (x86 platform) and Windows,
and you can start it in both stand-alone mode (access is limited to the local
computer) or Web server mode (which supports local and remote access).

You can access the information center directly on CD, or you can install it
on to one or more computers.

* The documentation FTP site}

ftp://ftp.software.ibm.com/software/integration/wbibrokers/docs

Download file wmb_help_Tlin.tgz for Linux (x86 platform) or
wmb_help_win.zip for Windows, and follow the instructions in the
installing_and_managing.htm file that is included in each compressed file.
The downloaded information center can also be started in stand-alone
mode or Web server mode.

On this site you can also find PDF files of topic collections for printing, and
translated versions of product readme files.

+ The online [[BM WebSphere Message Broker Information Center}
publib.boulder.ibm.com/infocenter/wmbhelp/v6rim0/index.jsp

The information center that is provided on the Quick Start CD, and that
available from the FIP site, include documentation plug-ins for WebSphere
Message Broker, WebSphere MQ Version 6.0, and WebSphere MQ Everyplace
Version 2.0.2.0.

The latest product readme file, in US English only, is available from the
[product support| Web site:

www.ibm.com/software/integration/wbhimessagebroker/support/
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Information sources

Publications
The following books are available for WebSphere Message Broker:
* WebSphere Message Broker Installation Guide (GC34-6866) (this book)
* Program Directory for WebSphere Message Broker for z/OS (GI13-0521)
* Program Directory for WebSphere Message Broker with Rules and Formatter for
z/OS (GI13-0522)
Related products

Online information centers and publications for other IBM products that you
might use with WebSphere Message Broker are available through the
[Publications Center}

www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi

Direct links are provided below.

WebSphere MQ
The WebSphere MQ documentation is included in the integrated
information center provided on the WebSphere Quick Start CD.

You can also access the WebSphere MQ information center
publib.boulder.ibm.com/infocenter/wmqv6/v6r0/index.jsp

DB2 Enterprise Server

Access the Version 9.1 information center
publib.boulder.ibm.com/infocenter/db2Tuw/v9/index.jsp

Derby

Access further [support information

db.apache.org/derby/

WebSphere MQ Everyplace®
The WebSphere MQ Everyplace documentation is included in the
integrated information center provided on the WebSphere Quick Start
CD.
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Information sources

xiv

WebSphere information on the Web

Follow links on the [WebSphere Web site] at www.ibm.com/software/infol/
websphere to:

Obtain the latest information about WebSphere products

Access manuals, white papers, IBM Redbooks™, and other information
sources

Download service and support information including SupportPac offerings
Access information about IBM Business Partners and associated offerings
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Summary of changes

This section describes changes in this edition of WebSphere Message Broker
Installation Guide. Changes that have been made since the previous edition of
the book are marked by vertical lines to the left of the changes.

Changes for this edition

* On all systems except z/OS, you can choose one of three license options
that support a range of features and capacity, according to your
environment and business requirements. You must configure your brokers
to operate in a mode that conforms to the license that you purchase.

A Trial Edition is also available on the Web, which you can download and

use without charge. See[“License requirements” on page 25|and [Chapter 4/
[‘Installation packages,” on page 41| for more information.

Use the information in this book to prepare for and install all editions,
including the Trial Edition; the process is unchanged unless otherwise
stated.

* Operating systems and hardware support; additions and changes have been
made on some platforms.

* Database support: IBM DB2 Version 9.5 is supported on most platforms.

* Additional instructions are provided for applying V6.1.0.2 service updates
to the Message Broker Toolkit.

* The appendix "System changes after installation” has been removed; the
content is included in the information center under Reference >
Installation.

* Minor technical corrections and editorial changes have been made
throughout the book.

© Copyright IBM Corp. 2005, 2008 XV
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Part 1. Planning

The first part of this book describes the environment that you need before you
can install WebSphere Message Broker. The information here addresses z/OS
and distributed systems.

* [Chapter 1, “System requirements,” on page 3|

* [Chapter 2, “Coexistence and migration,” on page 27|

* [Chapter 3, “National language support,” on page 37|

* [Chapter 4, “Installation packages,” on page 41

© Copyright IBM Corp. 2005, 2008 1
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Chapter 1. System requirements

Before you install WebSphere Message Broker, check that your systems meet
both the hardware and software requirements of the product. Details are
provided in these sections:

* [‘Hardware requirements” on page 4|

* ['Software requirements” on page 9|

The product readme file readme.html might contain updates to the
information in this chapter. Therefore, always check for later information in
the readme file. A single file is provided for WebSphere Message Broker that
includes information pertinent to all components and is available in these
locations:

* Before installation, on the product media.

The readme file is included in location \readmes\locale\ (where locale
identifies country, region, or language, for example en_US) on all of the
following disks:

- DVD (on Linux (x86 platform) and Windows only)
— Runtime components Disk 1 (all operating systems)
— Runtime components Disk 2 and Disk 3 (Windows only)
— Message Broker Toolkit Disk 1
* After installation, in the installation directory:

— For runtime components, in install_dir\readmes\locale\ (where locale
identifies country, region, or language, for example en_US).
— For the Message Broker Toolkit, in package_group_directory\wmbt\

documentation\locale\ (where locale identifies country, region, or
language, for example en_US).

The readme file is updated occasionally; access the [product support| Web site
to check that you have the latest level:

www.ibm.com/software/integration/whimessagebroker/support/

© Copyright IBM Corp. 2005, 2008
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The supported hardware and software environments are updated occasionally;
view the latest requirements information on the [product requirements| Web
site:

www.ibm.com/software/integration/whimessagebroker/requirements/

For information about license requirements, see [“License requirements” on|

The information in this chapter is repeated in the information center (under
Reference > Installation), so that you can check requirements online after
installation.

Hardware requirements

Check that your target computers are at the required level of support.|Table 1
describes what you need.

The Message Broker Toolkit is a required component that can be installed only
on Linux (x86 platform) and Windows. Therefore your target computers must
be able to support one of these two operating systems. You can install all
other components on all supported operating systems.

The hardware requirements for each supported operating system are given in
the following table. All support statements assume that the stated systems are
capable of running the required level of a compatible operating system and
have enough storage for the WebSphere Message Broker components that you
install, and all prerequisite products.

Table 1. Hardware requirements

Operating system Requirements’

AIX 64-bit IBM pSeries systems

Any hardware from IBM or other vendors that is capable of running
trademarked AIX systems’

HP-UX (Integrity Hewlett-Packard Integrity servers

platform)

HP-UX (PA-RISC Hewlett-Packard HP-9000 PA-RISC 2.0 processor servers

platform)

Linux (POWER 64-bit iSeries and pSeries IBM POWER processor based systems only
platforms)

Linux (x86 platform) [IBM eserver  xSeries® or equivalent Intel® based servers’®

Linux (x86-64 Sun Microsystems AMD64, EM64T, or compatible processor servers
platform)
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Hardware requirements

Table 1. Hardware requirements (continued)

Operating system Requirements’

Linux (zSeries

Any server capable of running one of the supported

platform) Linux (zSeries platform) releases

Solaris (SPARC Sun Microsystems SPARC processor servers

platform)

Solaris (x86-64 Sun Microsystems AMD64, EM64T, or compatible processor servers
platform)

Windows Windows x86 technology-compatible PC hardware®

z/0S* Any server capable of running one of the supported z/OS releases

Notes:

1. Always check the readme.html file and the product requirements Web site
for the latest information about supported hardware.

2. AIX systems must have passed a set of verification tests for compliance
with the AIX application binary and programming interfaces.

3. The Message Broker Toolkit is supported on 32-bit computers only. It
requires a computer with an Intel Pentium® III processor (or higher) that
has a speed of at least 700 MHz. This specification is the minimum
supported level; for improved performance, use a 2 GHz processor.

A minimum display resolution of at least 1024 x 768 is required for some
dialog boxes (for example, the Preferences dialog box).

4. See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter for
z/OS for further details.

DVDs are provided for Linux (x86 platform) and Windows; if you want to
install from DVD, your computer must have a DVD reader. If you plan to
install from CD, your computer requires a CD reader. For details of the CDs
and DVDs supplied, see [Chapter 4, “Installation packages,” on page 41]If you
prefer, you can download and install from images available from IBM
Passport Advantage®, if you are registered with this scheme.

Memory and disk space

WebSphere Message Broker memory and disk space requirements depend on
the installation operating system and the components that you are installing.
Distributed systems

* 512 MB of Random Access Memory (RAM) is required to support
runtime operations (1 MB equals approximately 1 000 000 bytes).

* 512 MB of RAM is required to support Message Broker Toolkit
operations on Linux (x86 platform) or Windows. This specification

Chapter 1. System requirements 5
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is the minimum supported level; for improved performance,
provide 1 GB of RAM (1 GB equals approximately 1 000 000 000
bytes).

Disk space requirements are dependent on the components that you
install and the working space that is required by those components
(for example, for WebSphere MQ queues and persistent messages).

Check that your computer has at least the space shown in
[on page 7| or [Table 3 on page 7, which provide guidance for both
permanent product requirements and temporary space. If you
install just one or two of the runtime components, the amount of
storage that is required is reduced by only a small amount.

Check that these requirements have not been updated in the latest
product readme file readme.html (the location of this file is
described at the beginning of this chapter).

If the installation directory and the temporary space are on the
same partition or drive, add together the two figures to check that
you have enough space available. If you do not, increase the
available storage or change the location of either the temporary
space or the installation directory. The temporary files are deleted
when installation has completed.

— On AIX, HP-UX, and Linux systems, the default temporary space
directory is /tmp.

— On Solaris systems, the default temporary space directory is
/var/tmp.

— On Windows systems, the default temporary space directory is
pointed to by the TEMP system variable. On some systems, the
variable TMP exists and is used before TEMP; therefore, you
might need to check or change the setting of both these
variables.

The installation wizard displays the requirements for permanent
space, but not for temporary space. If the figure that the installation
wizard displays is greater than the figure shown in [Table 2 on page
Iz or [Table 3 on page 7} use the larger amount and check that your
computer has sufficient space before you continue with the
installation.




Table 2. Disk space requirements (Linux and Windows)

Memory and disk space

Component Linux Linux (x86 Linux (x86-64 |Linux (zSeries | Windows'
(POWER platform)’ platform) platform)
platform)
Broker, 440 MB 440 MB 600 MB 440 MB 460 MB
Configuration plus 300 MB  |plus 300 MB |plus 300 MB |plus 300 MB |plus 300 MB
Manager, and temporary temporary temporary temporary temporary
User Name space space space space space
Server
Message Broker |Not available [1.9 GB Not available | Not available [1.9 GB
Toolkit plus 1.5 GB plus 1.5 GB
temporary temporary
space space
Notes:

1. The space required for the Message Broker Toolkit includes
space for the shared resources directory and the package group

directory:.

Table 3. Disk space requirements (UNIX)

Component AIX HP-UX HP-UX Solaris Solaris (x86-64
(Integrity (PA-RISC (SPARC platform)
platform) platform) platform)

Broker, 840 MB 740 MB 800 MB 860 MB 540 MB

Configuration plus 300 MB  |plus 300 MB |plus 300 MB |plus 300 MB |plus 300 MB

Manager, and temporary temporary temporary temporary temporary

User Name space space space space space

Server

Message Broker |Not available [Not available |Not available |Not available |Not available

Toolkit

* If you install one of the database products supplied with

WebSphere Message Broker, you need additional disk space:

— DB2 Enterprise Server requires approximately 300 MB. This
specification is for a Compact installation, which provides
sufficient function for WebSphere Message Broker; if you choose
a Typical or Custom installation, additional storage might be

required (see|[“Databases” on page 12).

— On Windows, ODBC (Open Database Connectivity) drivers for
Apache Derby require approximately 105 MB.

* When you create a broker, approximately 10 MB is required for the
broker tables. If you create databases to store data that is accessed
during message processing, additional space is required on those

systems.

Chapter 1. System requirements
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* If you intend to create more than one broker on any one computer,
you will need additional memory and swap space. For example,
you might create more than one broker at different versions to
complete migration. Plan for 1 GB RAM and 1 GB of swap space
for each broker, in addition to the space and memory requirements
of other applications.

You might need to increase these figures if you deploy complex
message flows to the brokers, or if you process large messages (of
many megabytes) or complex messages that contain many different
tags.

z/OS  See the section about DASD storage requirements in the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory
for WebSphere Message Broker with Rules and Formatter Extension for
z/OS.

Communications

Check that your computer has communications hardware that supports at
least one of the following protocols:

* NetBIOS

* SNALU 6.2

* SPX

s TCP/IP
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Software requirements

Software requirements

WebSphere Message Broker has specific requirements for operating system
software, and for supporting products:

* ["Operating system requirements”|

* ["Databases” on page 12|

+ [“Additional required products” on page 19|

+ ["Optional software and support” on page 24|

Operating system requirements

Ensure that you have the correct level of operating system software before
you install WebSphere Message Broker. Check the requirements for your

operating system in

Table 4. Operating system requirements

Operating Requirements’
system
AIX * AIX Version 5.3 (Technology Level 4)*
HP-UX * HP-UX 11i V2 (B.11.23) for Integrity (with HP-UX recommended patches for Java
(Integrity 5.0)
platform) * HP-UX 11i V3 (B.11.31) for Integrity
HP-UX e HP-UX 11i V2 (B.11.23) (with HP-UX recommended patches for Java 5.0)
(PA-RISC * HP-UX 11i V3
platform)
Linux (POWER |+ Linux PowerPC® Red Hat Enterprise Linux Version 4.0 (with service level Update 2)
platform) * Linux PowerPC Red Hat Enterprise Linux Version 5.0

* Linux PowerPC SUSE Linux Enterprise Server (SLES) 9 RC5 or above

e Linux PowerPC SUSE Linux Enterprise Server (SLES) 10
Linux (x86 * Linux Intel Red Hat Enterprise Linux Version 4.0 (with service level Update 2)
platform)® * Linux Intel Red Hat Enterprise Linux Version 5.0*

* Linux Intel SUSE Linux Enterprise Server (SLES) 9
¢ Linux Intel SUSE Linux Enterprise Server (SLES) 10*

Linux (x86-64
platform)

* Linux Intel Red Hat Enterprise Linux Version 4.0 (with service level Update 2)
* Linux Intel Red Hat Enterprise Linux Version 5.0

* Linux Intel SUSE Linux Enterprise Server (SLES) 9

* Linux Intel SUSE Linux Enterprise Server (SLES) 10

Linux (zSeries
platform)

* Linux zSeries (64-bit) Red Hat Enterprise Linux Version 4.0 (with service level
Update 2)

* Linux zSeries (64-bit) Red Hat Enterprise Linux Version 5.0

* Linux zSeries (64-bit) SUSE Linux Enterprise Server (SLES) 9

* Linux zSeries (64-bit) SUSE Linux Enterprise Server (SLES) 10

Solaris (SPARC

Solaris 9 (with SunSolve recommended Patch Cluster level)®

platform) * Solaris 10 (with SunSolve recommended Patch Cluster level)
Solaris (x86-64 |+ Solaris 10 (plus SunSolve recommended Patch Cluster level)®
platform)
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Table 4. Operating system requirements (continued)

Operating Requirements’

system

Windows’ * Windows XP Professional (with service level SP2)
* Windows Server 2003 Standard Edition
* Windows Server 2003 Enterprise Edition

z/0S?  IBM z/0S Version 1.7

IBM SMP/E for z/OS Version 3.3 or later

Notes:

1.

Always check the readme.html file and the product requirements Web site
for the latest information about supported hardware.

WebSphere Message Broker requires the xIC runtime libraries at Version 8

or above. If you do not have an xIC or xIC++ compiler at this version
installed, you must download and apply a from this Web site:

www. ibm.com/support/docview.wss?uid=swg24014302

You must also download and install the fix for HIPER IY83580,
which is available from this Web site

www. ibm.com/support/docview.wss?uid=isg11Y83580

On Linux (x86 platform), you might require the following additional
packages that are available with the operating system.

 If you choose to use the graphical interface to install on SUSE Linux
Enterprise Server, install package compat (at version 2002.12.6.0 or later).
This package is not required for console or silent installations.

 If you want to use the package manager (RPM), install package
rpm-build.

The Message Broker Toolkit is not supported on this operating system

version.

If you install the broker or the Configuration Manager component on this

operating system version, the recommended Patch Cluster level must
include patches 111711-16 (32-bit) and 111712-16 (64-bit).

If you install the broker or the Configuration Manager component on
Solaris 9, the recommended Patch Cluster level must include patch
119964-08.

WebSphere Message Broker is supported only in the Global zone, or in a
whole root non-global zone, and must be installed separately in each.

Windows operating systems are supported in 32-bit mode only.
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8. z/0S Version 1.7 must be at RSU0609 or later (for the target computer)
and you must install PTFs for APARs PK34716 and PK34041

See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS for further details and the latest information. In
particular, review the information in "Preventative Service Planning”.

In all operating environments except z/OS, defect support is available for
virtualization environments where they relate to releases that are already
supported by WebSphere Message Broker. Unless stated elsewhere in the
system requirements, WebSphere Message Broker has not been specifically
tested in virtualization environments. WebSphere Message Broker support is
therefore unable to assist in issues related to configuration and setup, or
issues that are directly related to the virtualization environment itself.

Support for 32-bit and 64-bit operation
WebSphere Message Broker operates in 32-bit mode, or 64-bit mode, or both,
on supported operating systems.

On operating systems where both modes are supported, 64-bit operation is the
default mode. You cannot create execution groups for a broker in a mode that
is not supported by its underlying hardware and software.

If you are migrating components from Version 6.0, broker operation and
execution group support have changed, indicated in and you might
need to make additional changes to your configuration. Read the migration
and configuration sections in the information center for further details.

The installation tasks that are described in this book do not depend on 32-bit
or 64-bit mode. The verification tasks that are described are applicable only to
32-bit operating systems, because the Message Broker Toolkit is supported
only in 32-bit environments.

Table 5. Support for 32-bit and 64-bit operation

Broker core 32-bit 64-bit

components execution execution
Platform and commands | groups groups
AIX! 64-bit Yes Yes
HP-UX (Integrity platform) 64-bit No Yes
HP-UX (PA-RISC platform)’ 64-bit Yes Yes
Linux (POWER platform)" > 64-bit No Yes
Linux (x86 platform) 32-bit Yes No
Linux (x86-64 platform) 64-bit Yes Yes
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Table 5. Support for 32-bit and 64-bit operation (continued)

Broker core 32-bit 64-bit

components execution execution
Platform and commands | groups groups
Linux (zSeries platform)" * 64-bit No Yes
Solaris (SPARC platform)' 64-bit Yes Yes
Solaris (x86-64 platform)" * 64-bit No Yes
Windows 32-bit Yes No
z/0OS 32-bit Yes No

Notes:

1. On this platform, the broker core components operate in 64-bit mode in
contrast to Version 6.0, where the broker core components operate in 32-bit
mode.

2. On this platform, you can no longer create or run 32-bit execution groups.
Execution groups can be only 64-bit mode.

Databases

A broker requires a database to contain operational and state data. You can
complete the WebSphere Message Broker installation program if you do not
have a suitable database installed on this system, but you must install one
before you create a broker. [Table 6 on page 14| shows the levels of database
that are supported on each operating system.

DB2 Enterprise Server V9.1 is supplied with WebSphere Message Broker for
distributed systems. You can install this version of DB2 on all supported
operating systems; its use is restricted to WebSphere Message Broker
components. A compact installation provides all the function that is required
by WebSphere Message Broker; typical and custom installations are also
available, and the installation program provides further details about
additional features and storage requirements.

On z/0S, you must obtain and install your own copy of DB2 Enterprise
Server. If you do not already have DB2 installed, contact your IBM
representative for further information and assistance.

On Windows only, you can use the embedded Derby database, which is
supported for test and evaluation purposes only. No other Derby database is
supported; you can use only the database embedded in the broker component.

To use the Derby database, you do not have to install any database server

code, but you must install the ODBC Drivers for Apache Derby that provide
an interface to that database. These drivers are available with the IBM DB2
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Run-Time Client for Windows Version 8.2.5, a copy of which is provided on
CD or DVD for WebSphere Message Broker on Windows only. If you use the
Windows Launchpad to install, select the option for the ODBC Drivers for
Apache Derby. If you do not use the Launchpad, install the DB2 Run-Time
Client directly from CD or DVD.

For a production system, install and configure your chosen enterprise
database; for example, DB2 Enterprise Server. If you use the Windows
Launchpad to install WebSphere Message Broker, you can install DB2
Enterprise Server at the same time.

Microsoft SQL Server, Oracle, and Sybase Adaptive Server Enterprise (ASE)
databases are also supported, as shown in [Table 6 on page 14l You must
acquire your own version of these products; they are not supplied with
WebSphere Message Broker.

Multiple brokers in the same installation can access the same database, if
appropriate, because all tables are qualified by the broker name. Brokers in
different installation locations on the same system cannot share a database.

You can configure message flows to access databases that hold data associated
with your message processing. The database software that is supported for
this purpose (known as user databases) is the same as that supported for a
broker database, with the addition of DB2 on 0S/400®, and Informix® on
most operating systems, as shown in [Table 6 on page 14|

You can use stored procedure support on all supported databases except
Informix.

In most situations, the broker that accesses the database does not have to be
running on the same operating system as the database server. For details
about local and remote database use, and existing restrictions, see
llocations” on page 17|
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Table 6. Supported databases

Operating DB2"* | SQL Server | Oracle"** Sybase’ | Informix"®
system 3
AIX 8.2 2000 SP3a’ |9i Release 2 Patch Set 4 |12.5 Dynamic Server Version
9.1 2005 SP1”  [(9.2.0.5, patch 3501955) 9.4 with UC7 fix pack
9.5
10g Release 1 Client SDK Version 2.90
10g Release 2° with UC4 fix pack
HP-UX 8.2 Not 10g Release 2 Not Not supported
(Integrity 9.1 applicable supported
platform) 9.5
HP-UX 8.2 Not 9i Release 2 Patch Set 4 [12.5 Dynamic Server Version
(PA-RISC 9.1° applicable |(9.2.0.5, patch 3501955) 9.4 with UC7 fix pack
platform)
10g Release 1 Client SDK Version 2.90
10g Release 2 with HC4 fix pack
Linux (POWER |8.2 Not 9i Release 2 Patch Set 4 |12.5 Dynamic Server Version
platform) 9.1 applicable |(9.2.0.5, patch 3501955) 9.4 with UC7 fix pack
9.5
10g Release 1 Client SDK Version 2.90
10g Release 2 with UC4 fix pack
Linux (x86 8.2 12000 SP3a’” |9i Release 2 Patch Set 4 |12.5 Dynamic Server Version
platform) 9.1 2005 SP17  [(9.2.0.5, patch 3501955) 9.4 with UC7 fix pack
10g Release 1 Client SDK Version 2.90
10g Release 2 with UC3 fix pack
Linux (x86-64 |82 |2000 SP3a” |9i Release 2 Patch Set 4 [12.5 Dynamic Server Version
platform) 9.1 2005 SP17  [(9.2.0.5, patch 3501955) 9.4 with UC7? fix pack
9.5
10g Release 1 Client SDK Version 2.90
10g Release 2 with UC3 fix pack
Linux (zSeries |8.2 Not 9i Release 2 Patch Set 4 |Not Dynamic Server Version
platform) 9.1 applicable |(9.2.0.5, patch 3501955) |supported |9.4 with UC7 fix pack
9.5
10g Release 1 Client SDK Version 2.90
10g Release 2 with UC4 fix pack
i5/0S® and V5R2 | Not Not applicable Not Not applicable
0S/400" V5R3 | applicable applicable
V5R4
Solaris (SPARC |8.2' 2000 SP3a’ |9i Release 2 Patch Set 4 |12.5 Dynamic Server Version
platform) 9.1 2005 SP1”  [(9.2.0.5, patch 3501955) 9.4 with UC7 fix pack
9.5
10g Release 1 Client SDK Version 2.90
10g Release 2 with UC4 fix pack
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Table 6. Supported databases (continued)

Operating DB2"?* | SQL Server | Oracle”*° Sybase' | Informix"®
system 3
Solaris (x86-64 |82 | Not 10g Release 1 125 Not supported
platform) 9.1 applicable |10g Release 2
9.5
Windows 8.2 2000 SP3a |9i Release 2 Patch Set 4 |12.5 Dynamic Server Version
9.1 2005 SP1 (9.2.0.5, patch 3501955) 9.4 with TC7 fix pack
9.5
10g Release 1 Client SDK Version 2.90
10g Release 2 with TC4 fix pack
z/08S 8.1" | Not Not supported Not Not supported
9.1 | applicable applicable
Notes:
1. Supported releases of DB2, Informix, Oracle, and Sybase can participate

as a Resource Manager in a distributed XA transaction, and can be
coordinated by WebSphere MQ as the XA Transaction Manager, unless
otherwise stated in the following notes. In WebSphere Message Broker,
this support is referred to as a globally-coordinated message flow. On
z/0S, all transactions are coordinated by Recoverable Resource Services
(RRS).

WebSphere MQ Version 6.0.1.0 or later is required for
globally-coordinated transaction support (XA).

If you use WebSphere MQ Version 6.0 as a transaction manager, all
datasources connected to DB2 from message flows in both 32-bit and
64-bit execution groups must connect to 64-bit DB2 instances.

XA coordination for messages in the MRM domain on Windows requires
DB2 Version 8 Fix Pack 10 (or later).

If you deploy message flows that access databases, you can define the
message flows to be coordinated so that updates to those databases are
synchronized with updates to other resources.

Supported connections to databases:

* ODBC drivers for Oracle and Sybase on all relevant systems, and for
SQL Server on Linux and UNIX systems, are supplied with WebSphere
Message Broker; alternative drivers are not supported on these
systems. For other systems and for other databases on all systems,
obtain these files from your database vendor.
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» JDBC drivers are not supplied with WebSphere Message Broker; obtain
these files from your database vendor. The following JDBC type 4
drivers are supported:

— IBM DB2 Driver for JDBC and SQLJ Version 9.1 and 9.5

— Microsoft SQL Server 2005 JDBC driver 1.1 (non-XA only)
— Oracle 10gR2 JDBC Driver

— Sybase jConnect for JDBC 6.05

— IBM Informix JDBC 3.00.JC3

JDBC type 4 transaction support that uses DB2 requires DB2 Version
9.1 Fix Pack 2 or later; support for DB2 Version 8 is not available.
Check the readme.html file for your product to check whether a fix pack
or other fix is required.
DB2 Version 8.2 is functionally equivalent to Version 8.1 Fix Pack 7.
If you define a connection to DB2 Version 8.2 from a broker that operates
in 64-bit mode, you must specify that you want to create a 64-bit
database instance. If you use DB2 Version 9.1, a 64-bit instance is the
default instance created on 64-bit operating systems.
Automatic Client Reroute for DB2 is supported on all platforms.
If you install the Oracle Database Server on 32-bit systems, or on mixed
mode systems on which you plan to create 32-bit execution groups, you
must also install the Oracle Runtime Client.
The Connect-Time Failover feature of Oracle RAC (Real Application
Clusters) in a non-XA environment only is supported on all Linux, UNIX,
and Windows systems.

Informix is supported only as a user database accessed by message flows;
you cannot create a broker database as an Informix database.

Each broker system requires only the client SDK; install the Dynamic
Server on the system on which you create databases.
Large Objects (LOBs) are not supported.

On Linux or UNIX systems, you can remotely access a SQL Server
database on Windows by using a supplied wire protocol driver.

On Linux (x86-64 platform), you can access SQL Server as a user
database only from a 32-bit execution group.
On AIX, Oracle 10g Release 2 requires the AIX fix for APAR I'Y89080.

If you use DB2 V9.1 on HP-UX (PA-RISC platform), you must set the
following environment variable, and export it in the broker’s
environment:

MQSI_SIGNAL_EXCLUSIONS=10
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10. If you have installed Red Hat Enterprise Linux V4.0 and DB2 Version 8
Fix Pack 9 on Linux (x86-64 platform), you must use a 32-bit database
instance. If you have a later release of DB2, you can use both 32-bit and
64-bit database instances.

11. You can configure message flows to access DB2 databases on i5/0S and
0OS/400 for user data. The message flows can run on any supported
broker platform. You cannot create a broker database as a remote DB2
database on i5/0S or OS/400 from any broker platform. For further
details of these restrictions, and for information about the PTFs that are
required with this product, see|“Database locations.”]

12. Solaris 10 on Solaris (SPARC platform) requires DB2 Version 8 Fix Pack 9;
Solaris 10 on Solaris (x86-64 platform) requires DB2 Version 8 Fix Pack 11.
13. For verification, evaluation, and test purposes only, you can optionally

use the Derby database that is embedded in the broker component. For a
production system, install and configure your chosen enterprise database.

14. On z/0S, DB2 is a mandatory requirement. You must create a unique
database for each broker.

* If you install DB2 Version 8.1, it must be at RSU0609 or later, and you
must install FMID JDB8817 (ODBC support) and PTFs for APAR
PK37248.

* If you install DB2 Version 9.1, you must install FMID JDB9917 (ODBC
support) and PTFs for APAR PK41943.

See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS for further details and the latest information. In
particular, review the information in "Preventative Service Planning”.

Database locations

You can create and configure a broker or user database on the local system
(where the broker is installed), or on a remote system, with the exception that
you cannot create a remote broker database on i5/0S, OS/400, or z/OS.

* You can use a local or remote database for user data, subject to the
following operating system restrictions:
DB2 databases on i5/0S and OS/400

— You can use only DB2 (UDB) databases on iSeries (System i)
running OS/400 or i5/0S.

— You must install OS/400 V5R2, or i5/0S V5R3 or V5R4.

— On Linux, UNIX, and Windows you can use DB2 Connect " to
connect. On Windows only, you can also use iSeries Access for
Windows.

— You cannot define globally-coordinated (XA) transactions.
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— You cannot configure message flows that include Rules and
Formatter Extension nodes to access a database on OS/400 or
i5/06.

— You can call stored procedures only if access to the remote
database is provided by DB2 Connect.

DB2 databases on z/OS

— You can use only DB2 (UDB) on zSeries. If you install DB2 V8.1,
you must apply the PTF for APAR PQ84976.

— You must use DB2 Connect on Linux, UNIX, and Windows.

— You cannot configure message flows that include Rules and
Formatter Extension nodes to access a database on z/OS.

See the Program Directory for WebSphere Message Broker for z/OS or
the Program Directory for WebSphere Message Broker with Rules and
Formatter for z/OS for further details.

WebSphere Information Integrator databases

— You can configure message flows on all distributed systems to
access user data in WebSphere Information Integrator for Linux,
UNIX, and Windows Version 8.2.

You can also configure message flows to access user data in
WebSphere Information Integrator Classic Federation for z/OS
Version 8.2, on broker platforms for which WebSphere
Information Integrator Classic Federation client code is provided.

— You can configure message flows on z/OS to access user data in
WebSphere Information Integrator Classic Federation for z/OS
Version 8.2. This support provides direct SQL connectivity with
the following z/OS data sources:

- IMS™

- VSAM

- ISAM

- Sequential files

- CA-IDMS

- CA-Datacom

- Software AG ADABAS
- DB2

WebSphere Information Integrator Classic Federation for z/OS
Version 8.2 is supported only with a CAF (Call Attachment
Facility) ODBC connection. This support does not include
two-phase commit, and database operations are not coordinated
by RRS.

* If you choose to use a remote database, you must configure the ODBC
connection to the database correctly.
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See the documentation for your database product to determine the best
options for your specific environment and requirements, and for information
about how to configure remote database access.

Additional required products

WebSphere Message Broker requires additional software products to run
successfully:

* [“WebSphere MQ"|
* [‘Java Runtime Environment” on page 21|

[‘IBM Installation Manager” on page 21
[" XML Toolkit” on page 23|
* ["Browsers” on page 23|

WebSphere MQ
All WebSphere Message Broker components require WebSphere MQ at the
minimum supported level shown in|Table zl

WebSphere MQ Version 6.0 (with tailored terms and conditions for use with
WebSphere Message Broker) is supplied on DVD (on Linux (x86 platform) and
Windows only) and on CD. If you have a previous version, you can use the
supplied DVD or CD to upgrade your current installation.

All runtime components (broker, Configuration Manager, and User Name
Server) require a WebSphere MQ queue manager. Each component of the
same type must have a dedicated local queue manager. More than one broker
cannot share a single queue manager; this restriction also applies to
Configuration Manager and to User Name Server components. Components of
different types can share a queue manager; for example, a broker and a
Configuration Manager on a single computer can share a queue manager.

Table 7. WebSphere MQ requirements

System Requirements

All distributed systems' WebSphere MQ Version 6.0 (or later)> **

z/08S° WebSphere MQ Version 6.0.0 with MQ Java™
Classes feature®

Notes:

1. WebSphere MQ is not required on Linux (x86 platform) or Windows
systems on which you install only the Message Broker Toolkit component.

2. The minimum set of components that you must install are the server and
Java Messaging components.

You can install WebSphere MQ before or after you install WebSphere
Message Broker. Install WebSphere MQ first for the following benefits:
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* WebSphere MQ user IDs and groups that components use are created
for you. See [“Setting up security” on page 57 for more details.

* The runtime components installation wizard checks that a supported
version of WebSphere MQ is installed. If you use the graphical or
console interface to install, you can choose to continue. However, if you
use the silent interface, installation fails unless you change the default
behavior of the installation wizard. See [Chapter 9, “Installing runtime]
[components,” on page 97| for more information about installation
options.

If you have already installed WebSphere MQ Version 6.0, check that your

installation includes the Java Messaging component; add it from the

WebSphere MQ media if it is not already installed.

On Windows, if you choose to install WebSphere MQ Version 6.0 from the

Launchpad, Express installation installs all required components for you. If

you use Advanced installation, you must select a custom installation and

include at least the server and Java Messaging components.

If you start the WebSphere MQ installation program directly on any
operating system, including Windows, you must select a custom
installation and include at least the server and Java Messaging
components.

If you want to use the WebSphere MQ Explorer, the graphical interface
that is available on Linux (x86 platform) and Windows only, install the
WebSphere Eclipse Platform Version 3.0.1 and the WebSphere MQ Explorer
components.

Other WebSphere MQ components are optional.

Check the availability of WebSphere MQ Version 6.0 on your operating
system; exact GA versions vary on different platforms.

Some specific broker functions might require later levels of WebSphere

MQ:

* Globally-coordinated (XA) transactions are supported only by
WebSphere MQ Version 6.0.1.0 or later.

* If you develop message flows that use WebSphere MQ Real-time
Transport with Multicast PGM support, you must apply APAR 1C47032
and USERMOD ANPGMO01 on WebSphere MQ Version 6.0..

On z/0S, WebSphere MQ is a mandatory requirement and must be
installed before you install WebSphere Message Broker. WebSphere MQ
must be at RSU0609 or later, and you must install FMID JMS6008 (MQ
connectivity) and PTFs for APARs PK53810 and PK55665.

See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS for further details and the latest information. In
particular, review the information in "Preventative Service Planning”.
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For details of WebSphere MQ products and supported versions, see the
[WebSphere MQ product requirements| Web site:

www. ibm.com/software/integration/wmq/requirements/

Java Runtime Environment
A Java Runtime Environment (JRE) is required on all platforms:

* On distributed platforms, Java Runtime Environment (JRE) Version 5 SR5 is
embedded in product components.

* On z/0S, you must acquire and install a JRE which must be at Version 5
SR5 or later.

See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS for further details and the latest information. In
particular, review the information in "Preventative Service Planning”.

WebSphere Message Broker supports any JMS 1.1 provider. You must consider
both this level of support and the supported JRE when you select a J]MS
provider whose client will be embedded in the broker.

IBM Installation Manager

All Rational® products at Version 7 or later are installed by IBM Installation
Manager, which also controls management, updates, licensing, and
uninstallation. The Message Broker Toolkit includes some Rational product
components, and therefore includes and uses Installation Manager.

The following Rational products are controlled by Installation Manager:
* Message Broker Toolkit Version 6.1

 Rational Application Developer (RAD) Version 7.0

* Rational Software Architect (RSA) Version 7.0

* WebSphere Integration Developer (WID) Version 6.1

Installation Manager is included with the Message Broker Toolkit and with
the other products in this list. When you first install the Message Broker
Toolkit (or another listed product), Installation Manager installs itself into a
directory that you specify, and then drives the installation of the Message
Broker Toolkit (or other listed product). If you install another product,
Installation Manager detects that it is already installed, and drives only the
installation of that product.

The Message Broker Toolkit shares certain resources with these other
products, if installed; for example, Eclipse features and plug-ins. All common
resources that are used by the installed products must be installed into a
single directory, which is known as the shared resources directory. You are asked
to specify the location of this directory when you first install the Message
Broker Toolkit or another Rational product.
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If you install another product, Installation Manager finds the shared resources
directory and uses its content during the installation process; you cannot
change the location of this directory. Installation Manager might also install
additional shared resources into the directory, including a single copy of every
Eclipse plug-in and feature of every installed Rational product at every
installed version.

The shared resources directory must be on a drive that is local to this
computer; you cannot specify a mapped or remote drive. The drive that you
specify for the shared resources directory must be of sufficient size to handle
all your expected installations; you cannot change or expand this directory
after installation. When you specify the directory during a first installation,
specify a new directory to ensure that it does not contain any files that might
cause conflicts.

Memory requirements for the Message Broker Toolkit are listed in m
fand disk space” on page 5] If you plan to install additional Rational products,
allow 2 GB for each additional product.

You must also allocate space in another directory in which you will manage
the workspace resources that you create for the installed Rational products.

When you install the Message Broker Toolkit, you are also asked to specify a
package group. Products that you install into a single package group share
Eclipse features and plug-ins, and these resources are loaded and viewable in
a single Eclipse instance. You can choose whether to install a product in a
package group with other products, or to install Message Broker Toolkit in a
new package group.

Each package group is isolated from products in other package groups,
although all package groups access a single shared resources directory. You
are asked to specify the location for the package group directory; you must
specify a new directory for each new package group. All product-specific files
are installed into this directory.

You might choose to use separate package groups to install different
combinations of the Message Broker Toolkit and other Rational products, so
that users can gain access to tailored Eclipse instances. When you install the
first product, the first package group is created with the name IBM Software
Development Platform. This name is fixed; you cannot change it.

If you choose to install another product into a new package group, another
group is created with the name IBM Software Development Platform_1. Each
new package group name follows this same naming pattern with the numeric
suffix incremented by one.
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For example, you might have defined the following package groups:

* IBM Software Development Platform into which you have installed the
Message Broker Toolkit and RAD

* IBM Software Development Platform_1 into which you have installed the
Message Broker Toolkit and RSA

* IBM Software Development Platform_2 into which you have installed
WID and RSA

When you start an Eclipse session in one of these package groups, you can
access only those resources that are associated with the products installed in
that group.

If you install later versions of any of the products in a different package
group, the updates are available only in that group. The shared resources
directory is also updated with later versions of shared files, which are
maintained separately from the original versions and are used only for the
upgraded products.

Each Rational product specifies which versions of plug-ins and features it
requires, if appropriate. Installation Manager ensures the integrity of these
requirements in each package group. If the product that you are currently
installing breaks this integrity, Installation Manager prevents the installation
into that package group.

Installation Manager also controls uninstallation of the Message Broker Toolkit
and the other products listed above; you cannot uninstall Installation Manager
until all listed products in all package groups have been removed.

Installation Manager is not required for any of the runtime components.

XML Toolkit
On z/0S only, you must install the IBM XML Toolkit for z/OS Version 1.9.

See the Program Directory for WebSphere Message Broker for z/OS or the Program
Directory for WebSphere Message Broker with Rules and Formatter Extension for
z/OS for further details and the latest information. In particular, review the
information in "Preventative Service Planning”.

Browsers

Documentation and online help is provided in an information center that is
accessed from the Message Broker Toolkit. For best viewing results, use
Internet Explorer Version 6.0 (or later) on Windows systems, or Mozilla 1.4.2
(or later) on Linux (x86 platform) systems.
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Some Linux (x86 platform) offerings do not install Mozilla by default. If you
plan to install the Message Broker Toolkit on your Linux (x86 platform)
system, check that a Mozilla-based browser version 1.4.2 (or later) is already
installed. If not, install Mozilla from the operating system media.

Optional software and support

The products listed in this section are not required, but they interact with
WebSphere Message Broker in ways that you might find useful. WebSphere
MQ Everyplace is supplied with WebSphere Message Broker; all other listed
products are not.

You do not need to install any of these products to complete the verification

procedure described in [Chapter 11, “Configuring and verifying your system,”|

* ['EIS client libraries”]

* ["WebSphere MQ Everyplace’|

* ['Tivoli License Manager”]

* ["Adobe Flash Player” on page 25|

EIS client libraries

If you plan to use WebSphere Adapters on any supported operating system,
you must obtain the appropriate Enterprise Information System (EIS) client
libraries from the relevant EIS vendor (for example, PeopleSoft, Siebel, or
SAP). The client libraries are required to complete connections between
Adapters nodes and the EIS; install them on each computer on which you run
a broker that hosts message flows that include Adapters nodes.

WebSphere MQ Everyplace

WebSphere MQ Everyplace Version 2.0.2.0 supports mobile and wireless
applications with robust and secure messaging. Installing WebSphere MQ
Everyplace in the broker domain gives these applications access to brokers
and other services.

WebSphere MQ Everyplace Version 2.0.2.0 is supplied on DVD (on Linux (x86
platform) and Windows only) and on CD in the supplemental package; see
[“Message Broker Toolkit and Supplemental packages” on page 49| For more
information about connecting your WebSphere MQ Everyplace clients to
brokers, see the information center.

Tivoli License Manager

WebSphere Message Broker includes support for IBM Tivoli® License Manager
Version 2.1. For more information about monitoring the use of IBM and other
product licenses with Tivoli License Manager, see the information center.
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Adobe Flash Player

If you want to run the Quick Tour from the information center in the Message
Broker Toolkit, you must install Adobe® Flash Player Version 6.0 (or later).
You can freely download Adobe Flash Player as a plug-in for the Web

browsers that are supported by the Message Broker Toolkit from the

www.adobe.com/products/flashplayer/

The Adobe Web site has details of the browsers that are supported for each
operating system.

License requirements

You can install WebSphere Message Broker to support a full range of
transformation and routing operations. If appropriate, you can install an
edition that supports a restricted set of functions, if that subset fulfills your
business requirements. You must ensure that your use and configuration of
the product conforms to the license agreement that you have purchased:

* WebSphere Message Broker Trial Edition. You can download this edition
from the Web, at no charge. This edition has its own license and terms and
conditions which is valid for 90 days. You can use all available function,
and are not limited in the number of resources that you create and
maintain.

¢ WebSphere Message Broker Starter Edition. If you expect to use all or most
of the features that are available, but will configure a limited domain
because of low capacity requirements, purchase this edition. You can use all
available function, but are limited in the number of resources that you
create and maintain.

* WebSphere Message Broker Remote Adapter Deployment. If you expect
your typical use of WebSphere Message Broker to be integration with
Enterprise Information Systems (EIS), purchase this edition. This edition
supports the subset of development resources that provide EIS interaction.

* WebSphere Message Broker. If you want to set up a full broker domain that
uses most or all of the features available, you require a full (unrestricted)
license.

WebSphere Message Broker for z/OS is not available in Remote Adapter
Deployment, or in Starter or Trial Editions. For further details about what
features are available for each license, and how to configure your domain, see
the Technical Overview and the Configuring sections in the information
center.

You can upgrade to the full license from another edition, if appropriate, by
purchasing another license.
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License requirements

Your license also covers use of the product for development and unit test
purposes. All developers in your organization, who are working on resources
and applications for the WebSphere Message Broker domain, can install one
copy of all components on their computer. They can create and configure a
broker domain without any functional or resource restrictions. Installation of
the Message Broker Toolkit limits this use to Windows and Linux (x86
platform) computers. The unit test environment is limited to these two
platforms even if you have purchased a license for WebSphere Message
Broker for z/OS.

You can also install the supplied WebSphere MQ and DB2 products on the
computers on which your developers create their development and test
configurations, regardless of the license agreement that you have purchased.

You can view licenses after installation in your chosen language in directory
install_dir/license/. Terms and conditions are also supplied for third-party
products used by WebSphere Message Broker. The file containing these details
is stored in the same license subdirectory when you install one or more
runtime components.

Contact your IBM representative if you want further details about license
agreements, or if you want to purchase additional licenses or change the type
of license that you have purchased.
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Chapter 2. Coexistence and migration

You can install WebSphere Message Broker Version 6.1 on a computer on
which you have installed previous versions; each version must be installed
into a unique directory, referred to in this book as install_dir. Different
versions can coexist and can run independently, and you can migrate product
components from one version to another, if and when appropriate. You can
also install multiple instances of the same version on the same computer, each
in its own separate location.

The following sections provide further details:
* ['Coexistence”
* ["Migration” on page 34|

If you have already installed WebSphere Message Broker Version 6.1
components, and want to apply the updates for V6.1.0.2, see
fupdates to existing installations” on page 35

Coexistence

You can install WebSphere Message Broker Version 6.1 on computers on
which you have installed previous versions:

* All runtime components (broker, Configuration Manager, User Name
Server) can coexist with runtime components at Version 5.0 and Version 6.0.

* The Message Broker Toolkit can coexist with the toolkit at Version 5.0,
Version 5.1, and Version 6.0.

The components and their purpose are described in [Chapter 6, “Choosing]
(what to install,” on page 71| The following sections describe how to achieve
coexistence, and the restrictions that apply.

Runtime components on distributed systems

When you install WebSphere Message Broker runtime components on
distributed systems, the default action taken by the installation wizard is to
complete a typical installation, which installs all components into a default
directory.
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The default directory for a typical installation is fixed and you cannot change
it. It includes the version and release of the product that you are installing in
the format v.r (version.release), and has the following values:

Linux /opt/ibm/mgsi/v.r
UNIX /opt/IBM/mgsi/v.r
Windows C:\Program Files\IBM\MQSI\v.r

These locations define the default value of install_dir on each platform.

Each unique version and release of the product is therefore installed into a
different default location.

The installation wizard differentiates only at version and release level; it does
not differentiate between different modification levels and fix pack levels. The
current modification level is 0 (Version 6.1.0). If a later modification level is
made available, it will install into the same default location with a v.r value of
6.1, and will therefore upgrade the Version 6.1.0 to the higher modification
level (for example, Version 6.1.1).

The wizard installs one fix pack over a previous fix pack, but prohibits you
from installing a previous modification or fix pack over a more recent one.

You can install the product at the same version and release more than once;
these installations can be at the same modification or fix pack level, or at
different levels. To achieve concurrent installations, you must choose a custom
installation and specify a unique directory for each installation (one of which
can be the default directory).

You can also use a custom installation to install into a non-default directory,
or to install a subset of the runtime components into the default, or another,
directory. If you have already installed one or more of the runtime
components into the specified directory, the installation wizard indicates this
situation on the page on which you choose further components.

If you have never completed a typical installation of the product on the
computer on which you have selected a custom installation, the directory is
initially set to the default directory, but you can change this default value to
your chosen value.

You cannot install runtime components into a directory that already contains a

previous installed version of these components. For example, you cannot
install Version 6.1 into a directory in which Version 6.0 is installed.
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If you install the product on any individual computer more than once, at any
version and release, the following restrictions apply:

* If you install the same version and release more than once, the native
installer support cannot manage these installations in the normal way. See
[‘Native software installer support” on page 33|for more details.

* Brokers associated with one installation cannot share a database with
brokers associated with a different installation.

* Components created in one installation cannot share a queue manager with
components created in a different installation.

During and after installation, files are also stored in the working directory,
which is associated with the current ID with which you are logged on. The
location depends on the operating system:

Linux and UNIX /var/mgsi
Windows %ALLUSERSPROFILE%\Application
Data\IBM\MQSI

(%ALLUSERSPROFILE% is the environment
variable that defines the working directory;
the default value is C:\Documents and
Settings\A11 Users but this setting might
have a different value on your computer.)

If you have multiple installations on a single computer, you can review the
contents of the file install.properties, which is stored in the root of the
working directory. For each installation at Version 6.1 and above, the file is
updated with the location and the level.

This example shows the contents of install.properties on a Windows
system on which a single installation has completed:

C\:\\Program\ Files\\IBM\\MQSI\\6.1=6.1.0.0

(The backslash character \ is interpreted as an escape character. It is inserted
before each non-alphabetic and non-numeric character in the string to
preserve the character. A colon, a space, and several backslash characters are
escaped in this example.)

If you want to revert your installation to a previous level for any reason, you
must uninstall the current version and install the previous product. Before
you uninstall, back up any resources (for example, databases) that you want
to return to a previous state.

Because the version and release are included in the directory structure when
you complete a typical installation, you can also install Version 6.1 and later
releases on the computer on which you have already installed either Version
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5.0 or Version 6.0. The Version 6.1 installation can coexist with the Version 6.0
(or Version 5.0) installation; you can operate the two configurations
independently.

If you use custom installations for Version 6.1 and later releases, you can
specify a unique installation directory for each release, and therefore achieve
coexisting releases on a single computer.

However, you cannot install Version 5.0 if you have already installed Version
6.1; the installation programs fail because Version 5.0 does not support
multiple installations on a single computer. If you want multiple versions, you
must install Version 5.0 before you install Version 6.1. This restriction does not
apply to installation of Version 6.0 with Version 6.1.

The number of installations of Version 6.1, or later, is limited only by the
availability of system resources.

Because different versions and releases can coexist, you can migrate to Version
6.1 from an earlier version in a controlled manner, and do not have to migrate
all components at the same time. For more information, see

Runtime components on z/OS

On z/0S you can install multiple copies of the runtime components on the
same computer if you specify a different installation location for each copy:.
The installations can run independently of each other. The code can be at the
same or different version and release levels; Version 5.0, Version 6.0, and
Version 6.1. The number of installations is restricted only by the availability of
system resources.

The default installation directory is /usr/1pp/mqsi/VxRxMx where VxRxMx
represents Version X, Release X, Modification X; for example, V6R1IMO. This
location defines the default value of install_dir on this platform.

For more details of locations, libraries, and file system paths, see the Program

Directory for WebSphere Message Broker for z/OS or the Program Directory for
WebSphere Message Broker with Rules and Formatter Extension for z/OS.
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Message Broker Toolkit on Linux (x86 platform) and Windows

Linux When you install the Message Broker Toolkit, the default action taken
by the installation wizard is to install Installation Manager files,
shared files, and product-specific files into the following directories:

* Installation Manager installation directory:
/opt/IBM/InstallationManager
 Shared resources directory:
/opt/IBM/SDP70Shared
* Package group directory:
/opt/IBM/WMBT610
This location defines the default value of install_dir on this platform.

For a description of these directories, see [Chapter 1, “System|
frequirements,” on page 3.|

You can install multiple instances of the Message Broker Toolkit
Version 6.1 on a single computer; each one must be in a separate
package group. Package groups are described in more detail in
[Chapter 1, “System requirements,” on page 3.

The Message Broker Toolkit Version 6.1 can coexist with the Message
Broker Toolkit Version 6.0. Only one instance of the Message Brokers
Toolkit Version 6.0 can be installed on a single computer.

The Message Broker Toolkit Version 6.1 can coexist with multiple
installations of runtime components, subject to the restrictions
described for those components.

Windows
When you install the Message Broker Toolkit, the default action taken
by the installation wizard is to install Installation Manager files,
shared files, and product-specific files into the following directories:

* Installation Manager installation directory:
C:\Program Files\IBM\InstallationManager
 Shared resources directory:
C:\Program Files\IBM\SDP70Shared
* Package group directory:
C:\Program Files\IBM\WMBT610
This location defines the default value of install_dir on this platform.

For a description of these directories, see [Chapter 1, “System|
frequirements,” on page 3.

You can install multiple instances of the Message Broker Toolkit
Version 6.1 on a single computer; each one must be in a separate

Chapter 2. Coexistence and migration 31



Coexistence

package group. Package eroups are described in more detail in
[Chapter 1, “System requirements,” on page 3

If you install the Message Broker Toolkit on Windows and you specify
your own directory location, be aware of the file system limit of 256
characters imposed by Windows file systems. This limit can cause
restrictions in path specification to resources (for example, message
flows), and might cause access problems if the combination of path
and resource name exceeds this limit. Keep installation locations and
resource names short to avoid problems associated with this
restriction.

The Message Broker Toolkit Version 6.1 can coexist with the Message
Brokers Toolkit Version 6.0. Only one instance of the Message Brokers
Toolkit Version 6.0 can be installed on a single computer.

The Message Broker Toolkit Version 6.1 can also coexist with the
Message Brokers Toolkit for WebSphere Studio Version 5.0 or Version
5.1 (but not both; Version 5.0 and Version 5.1 cannot be installed on
the same computer).

The Message Broker Toolkit Version 6.1 can coexist with multiple
installations of runtime components, subject to the restrictions
described for those components.

If your toolkit users operate in a team environment, and share resources with
each other, upgrade all users to Version 6.1 at the same time to ensure
continued access to all resources. Because toolkit resources are stored in a
different format when they are first saved in Version 6.1, your users might
experience compatibility problems in some circumstances if they are using an
older version of the toolkit.

Setting the environment for an installation

Because you can have more than one installation on a single computer, you
must ensure that the commands that you issue on that computer are directed
to the correct version of installed code.

* On Linux and UNIX systems, you must run the profile file mgsiprofile to
set up the correct environment before you run other WebSphere Message
Broker commands, for example, mqsicreatebroker. The profile file is stored
in install_dir/bin.

If you add the profile file to your system logon profile, it is run
automatically whenever you log on.

* On Windows systems, a command console is available for each installation
and you must invoke commands in the window for a particular installation.

If you prefer, you can run the mgsiprofile.cmd file, which is stored in
install dir\bin.
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If you have an earlier version of this product installed on this computer, check
that the earlier profile is not set for the current user ID. The two profiles are
incompatible and might cause unpredictable results. Consider using a
different user ID for each version and associate the correct profile with each
user ID to avoid potential problems.

This requirement is not applicable on z/OS systems.

For more details about mqsiprofile, see [Chapter 12, “What’s next,” on page|
-127.

Native software installer support

If you install the same version and release of the runtime components (for
example, 6.1) on a single computer more than once, the native installer
support cannot manage these installations in the normal way.

To guarantee that you uninstall the correct installation, use the appropriate
uninstall program uninstaller in the _uninst_runtime directory of that
installation. For further information about uninstalling the product, see the
information center.

You can view the install.properties file to see current installations and their
locations, and check the operating system representation:

AIX  The first installation is recorded as mgsivr, for example mqsi61.
Subsequent installations at the same vr level are displayed under the
first one when you list installed products with Islpp. If you use smitty
and geninstall to manage those subsequent installations, results are
unpredictable.

Linux, HP-UX, and Solaris
The first installation is recorded as mgqsi/vr, for example mqsi/61.
Subsequent installations at the same vr level are recorded as
mgqsi/vr-2, and so on.

Windows
The most recent installation that you completed for any given version
and release is displayed in Add/Remove Programs. No other
installations are shown here. Similarly, the Command Console option
in the Start menu is that associated with the most recent installation
for any given version and release.

If you uninstall the product at a specific version and release listed by
Add/Remove Programs, earlier installations that you completed on
the computer are not reinstated in that view.

To uninstall other instances, navigate to the directory that contains the
uninstallation program. For details of uninstallation tasks, see the
information center.
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Migration

Because you can install WebSphere Message Broker Version 6.1 on the same
computer as previous versions and other installations of Version 6.1, you are
not required to complete any migration tasks before you install Version 6.1.

WebSphere Message Broker Version 6.1 can coexist with the following

products:

* WebSphere Business Integration Event Broker Version 5.0

* WebSphere Business Integration Message Broker Version 5.0

* WebSphere Business Integration Message Broker with Rules and Formatter
Extension Version 5.0

* WebSphere Event Broker Version 6.0

* WebSphere Message Broker Version 6.0

* WebSphere Message Broker with Rules and Formatter Extension Version 6.0

You can choose how and when to migrate resources and components,
according to the instructions provided in the information center. You can
migrate all runtime components from the earlier versions listed above.

You cannot migrate the Message Broker Toolkit, but resources that you have
created in previous versions are mostly compatible with later releases. If you
do not use a repository such as CVS or ClearCase®, export your workspace to
retain the existing content and to support reversion to the previous version.
Import the workspace into Message Broker Toolkit Version 6.1.

Version 5.0 and Version 5.1
If you created message mappings (in .mfmaps files) in Version 5.0 or
Version 5.1, you must migrate them by using the mqsimigratemfmaps
command.

You can access all other resources in both Version 6.1 and Version 5.0
or Version 5.1.

If you edit and save resources in Version 6.1, you can no longer access
these resources in Message Broker Toolkit Version 5.0 or Version 5.1,
and can deploy them only to Version 6.1 brokers.

Version 6.0
You can access all resources that you have created in Version 6.0 in
both Version 6.1 and Version 6.0.

If you edit and save resources in Version 6.1, you can no longer access
these resources in Message Broker Toolkit Version 6.0, and can deploy
them only to Version 6.1 brokers.
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If you are migrating from Version 6.0 or Version 5.0, you can migrate existing
brokers only to a full version of WebSphere Message Broker Version 6.1. Do
not migrate brokers from an earlier version to the Trial Edition. If you choose
to migrate brokers by using the mqsimigratecomponents command, the
brokers are migrated in enterprise mode. If you have purchased either the
Starter Edition or the Remote Adapter Deployment, you must change the
mode of all your migrated brokers to comply with the terms of your license.
See [Chapter 13, “Checking the broker operation mode,” on page 131|for
further guidance.

To review migration information before you install, view a stand-alone or
online version of the information center. Access instructions are provided in
[“Where to find more information” on page xii

Applying updates to existing installations

If you have already installed WebSphere Message Broker Version 6.1.0.0 or
V6.1.0.1, you can update your existing installations without reinstalling the
components:

* For runtime components, follow the instructions in the section Installing >
Applying service to runtime components in your current Version 6.1
information center.

* For the Message Broker Toolkit, the update for V6.1.0.2 also requires an
update to Installation Manager, therefore the instructions in the information
center are incomplete for this fix pack. Full instructions are provided in
[“Upgrading the Message Broker Toolkit” on page 110.]

If you choose to change your license agreement from a full license to either of
the two specialized licenses, you might find that your current domain
configuration is no longer supported. For further details about what features
are available for each license, and how to configure your domain, see the
Technical Overview and the Configuring sections in the information center.
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Chapter 3. National language support

When you install WebSphere Message Broker, the installation wizards detect
your current system locale and perform the installation process in the
associated language.

If your current system locale is not one of the supported languages (indicated
below), you must select a supported language from those listed in the dialog
box that is presented by the wizard before you can continue with the
installation. This language is used for the installation process only and does
not affect other processes on your computer.

After installation on distributed systems, the user interface and message
catalogs are provided in the following languages:
* Brazilian Portuguese

* French

* German

e Italian

* Japanese

* Korean

 Simplified Chinese

* Spanish

¢ Traditional Chinese

* US English

After installation on z/OS, the message catalogs are provided in the following
languages:

* Japanese

* Simplified Chinese

* US English

The messages written to the z/OS operator console (which are a subset of the
messages written to the joblog) are in US English only, and are written in
mixed case or in uppercase, depending on your chosen system configuration.

WebSphere Message Broker provides a selection of message catalogs that are
used by the product components to report any problems that occur. If you use
other products in conjunction with WebSphere Message Broker, these products
might cause WebSphere Message Broker to report errors by using its message
catalogs, or might report problems by using their own techniques.
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Refer to the documentation supplied with any other products that you use to
determine the language support that they provide. In particular, check the
documentation supplied with the databases that you use, and documentation
provided with any user-defined node or parser that you integrate into the

WebSphere Message Broker environment.

You can install WebSphere Message Broker and WebSphere MQ in any
supported language; all language versions for each product are compatible
with all language versions for the other product. All languages for the
WebSphere MQ messaging products are included on the WebSphere MQ
server CD supplied with WebSphere Message Broker.

All messages generated for internal inter-component message exchange (for
example, deployed configuration messages and log files for the mqsireadlog
command) are generated in code page 1208 (UTF-8).

Locales

WebSphere Message Broker supports messages for the following locales.

Table 8. Supported locales

AIX HP-UX? Linux? Solaris Windows z/0S

en_US en_US.is088591, |en_US en_US English (United En_US.IBM-1047,
en_US.roman8 States) En_US.IBM-037

de_DE, De_DE |de_DE.ISO88591, |de_DE de German (Standard) |Not supported
de_DE.roman8

es_ES, Es_ES es_ES.ISO88591, |es_ES es Spanish (Modern Not supported
es_ES.roman8 Sort)

fr_FR, Fr_FR fr_FR.ISO88591, |fr_FR fr French (Standard) |Not supported
fr_FR.roman8

it IT, It_IT it_IT.ISO88591, it IT it ITtalian (Standard) Not supported
it_IT.roman8

pt_BR, Pt_BR pt_BR.ISO88591, |pt_BR pt_BR Portugese Not supported
pt_BR.utf8 (Brazilian)

Ja_JP, ja_JP ja_JP.SJIS, ja_JP ja_JP.PCK, ja |Japanese Ja_JP.IBM-939,
ja_JP.eucJP Ja_JP.IBM-930

Zh_CN, zh_CN |zh_CN.hp15CN |zh_CN zh, zh.GBK Simplified Chinese |Zh_CN.IBM-1388,

(China) Zh_CN.IBM-935

Zh_TW, zh_TW | zh_TW.big5, zh_TW zh_TW, Traditional Chinese |Not supported
zh_TW.eucTW zh_TW.BIG5 | (Taiwan)

ko_KR ko_KR.eucKR ko_KR ko Korean Not supported
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Notes:

1. These values are the same for HP-UX (Integrity platform) and HP-UX
(PA-RISC platform). Because syslog support is limited on HP-UX operating
systems, messages are written to the log in US English only.

2. These values are the same for Linux (POWER platform), Linux (x86
platform), Linux (x86-64 platform), and Linux (zSeries platform).

Other locales might be supported; check your operating system for further
details about locales.
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Chapter 4. Installation packages

This chapter describes the packages that are available, and the content of
those packages.

| Packaging options

[ Physical media and electronic images are available for the installation of
| WebSphere Message Broker:

I Physical media

I You can order the physical media for WebSphere Message Broker Start
[ Edition, Remote Adapter Deployment, and the full (unrestricted)
| licenses. Contents are described in[“Package contents” on page 43

I When you install the product from the media, you must configure
| your brokers to operate in the mode that conforms to the license that
I you have purchased. See the information center for further details.

I Electronic images

[ If you are registered with IBM Passport Advantage, you can

I download electronic images from IBM Passport Advantage for

I WebSphere Message Broker Start Edition, Remote Adapter

| Deployment, and the full (unrestricted) licenses. You can also request
| one set of the physical media.

| The electronic images exactly mirror the physical media that are
I described in [‘Package contents” on page 43 although are not

| formatted as CD or DVD images. For further information, and to
|
I

register, access the IBM [Passport Advantage Web site}
www.ibm.com/software/sw-1otus/services/cwepassport.nsf/wdocs/passporthome

I Electronic images are available on request for WebSphere Message
I Broker for z/OS. Contact your IBM representative for further
[ information and assistance.

[ When you install the product from these images, you must configure
| your brokers to operate in the mode that conforms to the license that
I you have purchased. See the information center for further details.
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Trial Edition electronic images

For distributed systems only, you can download electronic images for
WebSphere Message Broker Trial Edition from the developerWorks®

[WebSphere Message Broker download| Web site:

www. ibm.com/developerworks/downloads/ws/wmb/

Use this edition to assess how the product can address your business
requirements, and explore how you might use it with existing
software in your enterprise. The following restrictions apply:
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All product features are available, but the broker component
operates for only 90 days after installation.

Electronic images of WebSphere MQ are not included with the
WebSphere Message Broker Trial Edition. If you have not already
ordered and installed WebSphere MQ), you can obtain a trial version
from the developerWorks |WebSphere MQ download| Web site:

www. ibm.com/developerworks/downloads/ws/wmq/

The WebSphere MQ trial version includes the required Java and
Eclipse components.
Always check the WebSphere Message Broker readme file

readme.html on the port] Web site for the latest information
about supported trial versions:
www.ibm.com/software/integration/wbimessagebroker/support/
Electronic images of DB2 and ODBC Drivers for Apache Derby are
not included with the WebSphere Message Broker Trial Edition. If
you have not already ordered and installed DB2, or an alternative
supported database, you can download the latest fix pack for DB2
from the [DB2 Version 9.1 fix packs and client] Web site:

www. ibm.com/support/docview.wss?rs=71&uid=swg21255572

DB2 fix packs are complete installable images, and you can
download and install one for your chosen platform without charge,
and use it for 90 days.

If you want to use the Derby database, you can download a trial
version of IBM DB2 Run-Time Client for Windows Version 8.2.5
from the developerWorks Web site:

www. ibm.com/developerworks/db2/1ibrary/techarticle/dm-0409c1ine2/

Always check the WebSphere Message Broker readme file
readme.html on the Web site for the latest information

about supported trial versions:
www.ibm.com/software/integration/whimessagebroker/support/
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http://www.ibm.com/developerworks/downloads/ws/wmq/
http://www.ibm.com/software/integration/wbimessagebroker/support/
 http://www.ibm.com/support/docview.wss?rs=71&uid=swg21255572
http://www.ibm.com/developerworks/db2/library/techarticle/dm-0409cline2/
http://www.ibm.com/software/integration/wbimessagebroker/support/

Installation packages

* Physical images are not available for the Trial Edition.
* The Trial Edition is not available for z/OS.

If you choose to buy WebSphere Message Broker during or after the
trial period, and want to continue to use the product components that
you have installed, you do not have to reinstall product components,
but you must reconfigure existing brokers, and create new brokers, in
the mode that conforms to the license that you have purchased. You
can retain all the associated resources that you have developed or
imported during the trial period. For further information, see
{Chapter 13, “Checking the broker operation mode,” on page 131 and
the information center.

Unless otherwise stated in this book, you can use electronic images in the
same way as the physical CDs or DVDs, and all installation and set up
procedures described are identical for the trial and full packages.

Package contents

This section describes the contents of the physical media packages for
WebSphere Message Broker Start Edition, Remote Adapter Deployment, and
the full (unrestricted) licenses. The electronic images that you can download
have equivalent content.

The Trial Edition content is restricted; differences are described where they
apply.

The contents of the package depend on the product that you have ordered:

WebSphere Message Broker or WebSphere Message Broker with Rules and
Formatter Extension

The package includes product code for all supported distributed
operating systems, plus other optional software and documentation:

e The Quick Start CD, which contains documentation in PDF and
Eclipse plug-in formats. This CD is always at the top of the
package. For more detail about its content, see [“Message Broker]
[Toolkit and Supplemental packages” on page 49

* A set of plastic wallets that contain CDs for installation of runtime
components and required products, grouped by operating system.
The CDs are listed in [“Runtime packages” on page 45

* A plastic wallet that contains CDs for installation of the Message
Broker Toolkit on both Linux (x86 platform) and Windows, and for
supplemental software. The CDs are listed in [“Message Broker|
[Toolkit and Supplemental packages” on page 49

Chapter 4. Installation packages 43



Installation packages

* A plastic wallet that contains two DVDs, one for Linux (x86
platform) and one for Windows. The DVDs contains all required
and optional product code and additional optional software. The
structure of the DVD content is described in [“DVD package” on|

 If you have ordered WebSphere Message Broker with Rules and
Formatter Extension, an additional wallet contains the set of CDs
shown in|“Rules and Formatter Extension packages” on page 53]
The Rules and Formatter extension code is not included on DVD;
you must install this extension from CD.

* This Installation Guide, printed in US English.
* The Quick Start Guide, printed in US English, French, and Japanese.

WebSphere Message Broker for z/OS or WebSphere Message Broker with
Rules and Formatter Extension for z/OS

44  Installation Guide

The package includes product code for the z/OS operating system on
tape, plus other optional software and documentation. In addition,
you receive the product for Linux (x86 platform) and Windows,
because the Message Broker Toolkit is available only on those
operating systems.

* Two plastic wallets that contain CDs for installation of runtime
components and required products, one for Linux (x86 platform)
and one for Windows. The CDs are listed in [“Runtime packages’]|

* A plastic wallet that contains CDs for installation of the Message
Broker Toolkit on both Linux (x86 platform) and Windows, and
supplemental CDs. The CDs are listed in |”Message Broker Toolkit|
[and Supplemental packages” on page 49|

* A plastic wallet that contains two DVDs, one for Linux (x86
platform) and one for Windows. The DVDs contains all required
and optional product code and additional optional software. The
structure of the DVD content is described in [“DVD package” on|

e z/0S tapes
For information about tapes supplied with WebSphere Message
Broker for z/OS, see the Program Directory for WebSphere Message
Broker for z/OS or the Program Directory for WebSphere Message Broker
with Rules and Formatter for z/OS.

¢ This Installation Guide, printed in US English.
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The contents listed in are supplied for installation of runtime
components and associated products.

Runtime packages

WebSphere MQ and DB2 images are not included in the Trial Edition.

P>
The physical packages are marked with the symbol .

Table 9. CDs and images supplied for WebSphere Message Broker for runtime components and

associated products

Operating CD label Description

System'

AIX WebSphere Message Broker Version 6.1 AIX Product code Version 6.1.0.22

(Runtime Disk 1)

WebSphere MQ Version 6.0 AIX (Runtime Disk
2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 AIX (Runtime Disk 3)

US English product code and
documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 AIX (Runtime Disk 4)

National Language additions

HP-UX (Integrity
platform)

WebSphere Message Broker Version 6.1 HP-UX
on Itanium (Runtime Disk 1)

Product code Version 6.1.0.2>

WebSphere MQ Version 6.0 HP-UX on Itanium
platform (Runtime Disk 2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 HP-UX on Itanium (Runtime Disk 3)

Product code and documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 HP-UX on Itanium
(Runtime Disk 4)

National Language additions

HP-UX (PA-RISC
platform)

WebSphere Message Broker Version 6.1 HP-UX
(Runtime Disk 1)

Product code Version 6.1.0.2°

WebSphere MQ Version 6.0 HP-UX (Runtime
Disk 2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 HP-UX (Runtime Disk 3)

Product code and documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 HP-UX (Runtime Disk 4)

National Language additions
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Table 9. CDs and images supplied for WebSphere Message Broker for runtime components and
associated products (continued)

Operating CD label Description
System'
Linux (POWER | WebSphere Message Broker Version 6.1 Linux Product code Version 6.1.0.22
platform) on POWER (Runtime Disk 1)
WebSphere MQ Version 6.0 Linux on POWER | Product code
platform (Runtime Disk 2)
DB2 V9.1 for WebSphere Broker Products Product code and documentation
Version 6.1 Linux on POWER (Runtime Disk 3)
DB2 V9.1 for WebSphere Broker Products, NLV | National Language additions
Additions Version 6.1 Linux on POWER
(Runtime Disk 4)
Linux (x86 WebSphere Message Broker Version 6.1 Linux Product code Version 6.1.0.22
platform) x86 (Runtime Disk 1)

WebSphere MQ Version 6.0 Linux x86 (Runtime
Disk 2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 Linux x86 (Runtime Disk 3)

Product code and documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 Linux x86 (Runtime Disk
4)

National Language additions

Linux (x86-64
platform)

WebSphere Message Broker Version 6.1 Linux
x86-64 (Runtime Disk 1)

Product code Version 6.1.0.22

WebSphere MQ Version 6.0 Linux on x86-64
platform (Runtime Disk 2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 Linux x86-64 (Runtime Disk 3)

Product code and documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 Linux x86-64 (Runtime
Disk 4)

National Language additions

Linux (zSeries
platform)

WebSphere Message Broker Version 6.1 Linux
on System z (Runtime Disk 1)

Product code Version 6.1.0.2°

WebSphere MQ Version 6.0 Linux on zSeries
platform (Runtime Disk 2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 Linux on System z (Runtime Disk 3)

Product code and documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 Linux on System z
(Runtime Disk 4)

National Language additions
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Table 9. CDs and images supplied for WebSphere Message Broker for runtime components and
associated products (continued)

Operating CD label Description

System'

Solaris (SPARC | WebSphere Message Broker Version 6.1 Solaris | Product code Version 6.1.0.2
platform) (Runtime Disk 1)

WebSphere MQ Version 6.0 Solaris (Runtime
Disk 2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 Solaris (Runtime Disk 3)

Product code and documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 Solaris (Runtime Disk 4)

National Language additions

Solaris (x86-64
platform)

WebSphere Message Broker Version 6.1 Solaris
on x86-64 (Runtime Disk 1)

Product code Version 6.1.0.2°

WebSphere MQ Version 6.0 Solaris on x86-64
(Runtime Disk 2)

Product code

DB2 V9.1 for WebSphere Broker Products
Version 6.1 Solaris on x86-64 (Runtime Disk 3)

Product code and documentation

DB2 V9.1 for WebSphere Broker Products, NLV
Additions Version 6.1 Solaris on x86—64
(Runtime Disk 4)

National Language additions

Windows

WebSphere Message Broker Version 6.1
Windows (Runtime Disk 1)

Product code Version 6.1.0.2°

WebSphere MQ Version 6.0 Windows (Runtime
Disk 2)

Product code®

IBM DB2 V9.1 for WebSphere Broker Products
Version 6.1 Windows (Runtime Disk 3)

Product code and documentation®

Notes:

1.

On all operating systems, the CDs and images for WebSphere MQ

(Runtime Disk 2) and DB2 (Runtime Disks 3 and 4) are not included in the
Trial Edition. You must obtain prerequisite software from other sources to

support the Trial Edition of WebSphere Message Broker. See

foptions” on page 41| for more information.
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2. Disk 1 includes the following resources:

Runtime components installation files Version 6.1.0.2.

IBM DB2 Run-Time Client V8.2.5 (Windows only). If you want to use
the Derby database that is embedded in the broker component, install
this product to install the ODBC Drivers for Apache Derby that are
required. This product is not included in the Trial Edition. You can
obtain a trial version of this software; see [“Packaging options” on page
for more information.
Launchpad (Windows only).
Quick Tour (stand-alone executable program on Windows only).
License files. These files are used by the installation wizard and are
supplied in all supported languages.

Readme files. The readme.html files contain late updates about the
product and its documentation and are supplied in all supported
languages.

Installation Guides. PDF files of this Installation Guide are supplied in
all supported languages to which it has been translated.

Sample scripts. Use these sample response files to run the silent
interface to install and uninstall components.

3. The Launchpad and stand-alone Quick Tour are also included on Disk 2
and Disk 3 on Windows.
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Message Broker Toolkit and Supplemental packages

The contents listed in are supplied for installation of the Message
Broker Toolkit and supplemental software products.

Supplemental product images are not included in the Trial Edition.

The physical package is marked with the symbols and .

Table 10. CDs and images supplied for the Message Broker Toolkit

Operating CD label Description
System
Linux (x86 WebSphere Message Broker Toolkit Version 6.1 |+ Product code Version 6.1.0.2'
platform) Linux x86 Disk 1 ¢ Installation Manager”
 Additional resources’
WebSphere Message Broker Toolkit Version 6.1 | Product code
Linux x86 Disk 2
WebSphere Message Broker Toolkit Version 6.1 | Product code
Linux x86 Disk 3
Windows WebSphere Message Broker Toolkit Version 6.1 |* Product code Version 6.1.0.2
Windows Disk 1 * Installation Manager2
» Additional resources®
WebSphere Message Broker Toolkit Version 6.1 | Product code
Windows Disk 2
WebSphere Message Broker Toolkit Version 6.1 | Product code
Windows Disk 3
Multiplatforms | WebSphere MQ Everyplace Version 2.0.2.0 for Product code
Multiplatforms
Quick Start CD Documentation*
Notes:

1. The product code includes the information center.

2. Installation Manager is installed only if does not already exist on the target
computer; this product is required to manage the Message Broker Toolkit

installation.

3. Disk 1 includes the following resources:

* Message Broker Toolkit installation files Version 6.1.0.2.

* Launchpad (Windows only).

* Quick Tour (stand-alone executable program on Windows only).
* License files. These files are used by the installation wizard and are

supplied in all supported languages.

Chapter 4. Installation packages




Toolkit and Supplemental packages

* Readme files. The readme.htm] files contain late updates about the
product and its documentation and are supplied in all supported
languages.

* Installation Guides. PDF files of this Installation Guide are supplied in
all supported languages to which it has been translated.

* Sample scripts. Use these sample response files to run the silent
interface to install and uninstall components.

These files are identical to the equivalent files described in
[packages” on page 45

4. The Quick Start CD is included at the top of the physical product package.
When you have finished using this CD, add it to the supplemental
package for safe-keeping.

You can explore the contents of the CD or electronic image on all

supported distributed operating systems, but some items have restricted

usage, as indicated below:

* A stand-alone integrated information center that includes documentation
plug-ins for WebSphere Message Broker Version 6.1, WebSphere MQ
Version 6.0, and WebSphere MQ Everyplace Version 2.0.2.0.

An information center is provided for Windows and Linux (x86
platform) only. View or install the one that is appropriate for your
operating system.

* Readme files (US English and translations).

* PDF files for the Quick Start Guide (US English and translations).

* PDF files for this Installation Guide (US English and translations).
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DVD package

DVDs (type DVD-R, size DVD-5) are supplied for Linux (x86 platform) and
Windows only. The DVD labels are WebSphere Message Broker Version 6.1
Linux x86 and WebSphere Message Broker Version 6.1 Windows.

DVD images are not included in the Trial Edition.

The physical package is marked with the symbol .

The DVDs contain code for the following products:

¢ WebSphere Message Broker Version 6.1.0.2 runtime components
* Message Broker Toolkit Version 6.1.0.2

¢ WebSphere MQ Version 6.0

* DB2 Enterprise Server Version 9.1

¢ DB2 Run-Time Client Version 8.2.5 (Windows only)

If you use the Launchpad to install on Windows (described in

[“Installing with the Windows Launchpad,” on page 85), the Launchpad

navigates the DVD to find the products and components that you have
chosen to install, and you do not have to be familiar with the structure of the
DVD contents.

If you install on Linux (x86 platform), or you install on Windows and choose
not to use the Launchpad, use the DVD structure shown in|Table 11|to find
what you want.

Table 11. DVD contents

Directory

Description

\ (root)

* Runtime components Version 6.1.0.2 installation files
*+ (Windows only) Launchpad and Quick Tour'

\DB2_Enterprise_Server_V9.1

DB2 Restricted Enterprise Server Version 9.1 installation images®

\DB2_Runtime_Client_V8.2

(Windows only) DB2 Runtime Client Version 8.2.5

\IBMInstallationManager

Installation Manager installation images

\installation_guide

Installation Guides®

\license

License files®

\Message Broker_Toolkit_V6

Message Broker Toolkit Version 6.1.0.2 installation reposi’cory4

\readmes

Readme files®

\sample-scripts

Sample response files®

\WebSphere MQ V6.0

WebSphere MQ installation images
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Notes:

1. This item is a stand-alone executable version of the Quick Tour, which is
available only on Windows. On Linux (x86 platform) and Windows, you
can access the Quick Tour from the Message Broker Toolkit.

2. On Linux (x86 platform), this directory has two subdirectories: one for US
English and one for National Language Additions.

3. The files in this directory are identical to the equivalent files described in
[‘Runtime packages” on page 45

4. The files in this directory are not an installation image for the Message
Broker Toolkit but are in the format required by Installation Manager to
install the Message Broker Toolkit.
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Rules and Formatter Extension packages

The contents listed in are supplied only if you have purchased
WebSphere Message Broker with Rules and Formatter Extension. The Rules
and Formatter Extension components are not included on the DVDs.

Rules and Formatter Extension images are not included in the Trial Edition.

The physical package is marked with the symbol

Table 12. CDs and images supplied for the Rules and Formatter Extension

Operating CD label Description
System'
AIX Rules and Formatter Run-time Extension V6.1 Product code and documentation

AIX

HP-UX (PA-RISC

Rules and Formatter Run-time Extension V6.1

Product code and documentation

platform) HP-UX
Linux (x86 Rules and Formatter Run-time Extension V6.1 | Product code and documentation
platform) Linux x86

Rules and Formatter Design-time Extension
V6.1 Linux x86

Product code and documentation

Solaris (SPARC
platform)

Rules and Formatter Run-time Extension V6.1
Solaris

Product code and documentation

Windows

Rules and Formatter Run-time Extension V6.1
Windows

Product code and documentation

Rules and Formatter Design-time Extension
V6.1 Windows

Product code and documentation

Notes:

1.

not available for HP-UX (Integrity platform), Linux (POWER platform),
Linux (x86-64 platform), Linux (zSeries platform), or Solaris (x86-64

platform).
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Part 2. Preparation

This part of the book describes the tasks that you might need to complete
before you start installing WebSphere Message Broker. The information here
addresses z/OS and distributed systems.

+ [Chapter 5, “Preparing the system,” on page 57|

s [Chapter 6, “Choosing what to install,” on page 71|

* [Chapter 7, “Choosing an installation interface,” on page 75

© Copyright IBM Corp. 2005, 2008
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Chapter 5. Preparing the system

You must complete several tasks on some operating systems before you install
WebSphere Message Broker. You might want to complete other tasks,
depending on your installation intentions.

Always read the following section:
* [‘Setting up security”]

If you are installing on a distributed system, read the following section:
¢ [‘Accessing CDs and DVDs” on page 62|

If you are installing on Linux or UNIX systems, read the following section:
* [’Checking the kernel configuration on Linux and UNIX systems” on page]
69

When you have completed these tasks, follow the installation instructions in
the appropriate chapter:

¢ [Chapter 8, “Installing with the Windows Launchpad,” on page 85|

* |Chapter 9, “Installing runtime components,” on page 97

» [Chapter 10, “Installing the Message Broker Toolkit,” on page 103|

Setting up security

This section describes security requirements:

* To install the product

« To complete the procedures described in [Chapter 11, “Configuring and]
[verifying your system,” on page 119

After installation, check the topics under the Security heading in the
information center to review and implement the security requirements for
additional users doing other tasks.

Security control of WebSphere Message Broker components, resources, and
tasks depends on the definition of users and groups of users (principals) to
the security subsystem of the operating system. Check that you have the
correct authority, and that the required principals are in place, before you
install WebSphere Message Broker.
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User ID restrictions: some operating systems and other products impose
restrictions on user IDs:

On Windows systems, user IDs can be up to 12 characters long but on
Linux and UNIX systems, and on z/OS, they are restricted to eight
characters. Database products, for example DB2, might restrict also user IDs
to eight characters. If you have a mixed environment, ensure that the user
IDs that you use within the broker domain are limited to a maximum of
eight characters.

Ensure that the case (upper, lower, or mixed) of user IDs in your broker
domain is consistent. In some environments, uppercase and lowercase user
IDs are considered the same, but in other environments, user IDs of
different case are considered unique. For example, on Windows the user
IDs 'tester' and 'TESTER' are identical, but on Linux and UNIX systems they
are recognized as different user IDs.

Check the validity of spaces and special characters in user IDs to ensure
that, if used, these characters are accepted by all relevant systems and
products in your broker domain.

If your user ID does not conform to these restrictions, you might have
problems with installation or verification. Use an alternative user ID, or create
a new one, to complete installation and verification.

Set up the required security for the operating systems that you are using:

If you are installing on Linux or UNIX systems, go to|”Security on Linuxl
fand UNIX systems.”|

If you are installing on Windows, go to[“Security on Windows systems” on|

If you are installing on z/OS, go to [‘Security on z/OS systems” on page 61

Security on Linux and UNIX systems

Before you install WebSphere Message Broker, you must set up the required
security.

Use the security facilities provided by your operating system to complete
these tasks; for example, the Systems Management Interface Tool (SMIT) on
AIX, or the System Administration Manager (SAM) on HP-UX.
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Complete the following actions:

1.

Log in to the system. On AIX, you must log in as root. On Linux, and on
other UNIX computers, your user ID must have root authority to complete
installation. Follow your local security guidelines to acquire root authority;
either log in as root, or log in as another user and become root.

The use of a user ID other than root itself has some advantages; it
provides an audit trail of the user ID that performs installation and it
limits the scope of root authority to tasks performed in a single session. It
might also be required if you are logging in from a remote system.

If you are installing only the Message Broker Toolkit on Linux (x86
platform), continue with step

Create a new security group called mqgbrkrs.
Add your current logon ID to the group mqbrkrs.

If you are installing on a system that will run as a production server (with
the broker and perhaps Configuration Manager components installed),
create an additional new user ID for use only with product components. If
you create a new ID, add it to the mqgbrkrs group.

On a Linux (x86 platform) system that you are running as a development
or test system, you can use the ID that you logged in with to complete
installation.

If you have already installed WebSphere MQ on this system, a group
called mgm and a user called mgm have already been defined. If you have
not yet installed WebSphere MQ, you must create this user and group.

Add to the group mgm the user ID that you logged in with, the new user
ID (if you created one), and the user ID mqm.

On some systems, you might have to log off and log on again for these
new group definitions (mgbrkrs and mqgm) to be recognized.

Verification procedures are provided for Linux (x86 platform) only. To
complete verification, you do not require root authority; if you do not
want to complete verification with root authority, log off when you have
completed installation. Log in with the same or a different user ID, but do
not become root. If you have not already done so, add your
post-installation user ID to the groups mgbrkrs and mqm before you
launch the Message Broker Toolkit.
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Security on Windows systems

Before you install WebSphere Message Broker runtime components or the
Message Broker Toolkit, log on with a user ID that has Administrator
authority, but is not the Administrator ID.

If you are installing the runtime components, the installation wizard calls the

mgqsisetsecurity command which completes the following tasks:

1. Creates a new security group called mgbrkrs.

2. Adds your current (logged on) user ID to the group mqbrkrs.

3. Adds your current user ID to the group mqm, if that group exists.
The mqm group exists if have already installed WebSphere MQ on this
system. If you have not, call the mqsisetsecurity command when you
have completed WebSphere MQ installation. If you use the Windows

Launchpad (described in [Chapter 8, “Installing with the Windows|
[Launchpad,” on page 85), it completes WebSphere MQ installation first.

If you prefer to create principals before you install WebSphere Message
Broker, use the security facilities provided by the Windows Control Panel to
complete these tasks.

If you are running Terminal Services on this system, you must also change
user mode to ensure that actions taken during installation are completed
correctly; for example, the creation of .ini files and other related files in the
default system directory C:\Windows. If you do not make this change, files
might be written to other locations and, although the installation might
complete successfully, the product might not work as expected.

Enter the following command to change user mode before you install any
product components:

change user /install

When installation is complete, enter the following command to restore the
original user mode:

change user /execute

To complete verification, your user ID must have Administrator authority. If
you log in with a different user ID from that with which you perform
installation, you must add that user ID to the groups mqgbrkrs and mqm. Use
either the Windows security facilities or the mqsisetsecurity command (run
this command after you have logged on with that different ID) to complete
these additions.
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Security in a domain environment

If you intend to install in a Windows domain environment, you must decide
whether you want to install WebSphere Message Broker on the domain
controller.

If you install WebSphere Message Broker on the domain controller:

1. Install on the domain controller before you install on any of the
domain workstations.

The WebSphere Message Broker installation program creates the
mgbrkrs local group only if you have Domain Administrator
authority; if you do not have this authority when you install,
create this group at a later time.

In a domain environment, WebSphere Message Broker also
requires a global group, Domain mqbrkrs, which you must create
by using Windows security facilities. You must also add Domain
mgqbrkrs to the local group mqgbrkrs.

2. Install on each workstation that is a member of the same domain.
The WebSphere Message Broker installation program creates the
mgqbrkrs local group. Add the Domain mqbrkrs global group to
the local mgbrkrs group.

If you do not install WebSphere Message Broker on the domain controller:

1. Create the Domain mgbrkrs global group on the domain controller
system.

2. Install the required product components onto each workstation in
the domain. After installation has completed, add the Domain
mgqbrkrs global group to the local group.

Security on z/0OS systems

The user ID that you use to install the product must be no more than eight
characters in length. It must also have suitable RACF® privileges to perform
SMP/E installation in your environment. The user ID must have a valid
OMVS segment, because the product installs into the file system paths
specified during the SMP/E APPLY processing.
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Accessing CDs and DVDs

When you install or upgrade WebSphere Message Broker, you can access CDs
or DVD on the local system, or you can set up a shared drive and access the
shared resource from multiple computers.

The information in the following sections is relevant to both CDs and DVDs.
All references are to CDs; DVD behavior is identical. DVDs are available for
Linux (x86 platform) and Windows only.

You can also install or upgrade from installation images that you have
obtained from Passport Advantage, if you are registered with this scheme. If
you want to use this option, read the instructions that are provided with the
packages that explain how to download and extract the images. Use this

section to set up local or remote access to these images in the same way that
you do for a CD or DVD.

If you are installing on Windows, you cannot enter a Universal Naming
Convention (UNC) path (\\server\drive) to access the installation program;
you must map the drive, as shown in a later example, otherwise the Java
process times out. If you cannot map the drive, or choose not to map the
drive, copy the contents of the CD to a local drive and install from that drive.

For local installations, see [‘Accessing CDs and DVDs on the local system”} for
remote installations, see|“Accessing CDs and DVDs on a remote system” on|

Accessing CDs and DVDs on the local system

If you want to install product components from a local CD or DVD, complete
this task. Always consult your operating system documentation for exact
details of this task.

AIX

—_

Log in and ensure that your user ID has root authority.

2. Complete the security setup described in [“Security on Linux and|
[UNIX systems” on page 58

3. Create a CD mount point directory:
mkdir /cdbroker

where /cdbroker is the mount point.

4. Insert the CD that you want to access into the drive of the
computer on which you want to install one or more product
components.

62 Installation Guide



HP-UX

Linux

Accessing CDs and DVDs locally

5. Use SMIT to mount the CD, or use the following command:
mount -r -v cdrfs /dev/cd@ /cdbroker

where /dev/cd0 is the CD device and /cdbroker is the mount point.
You are now ready to install the product that is supplied on this CD.

The HP-UX CDs have the format ISO 9660, with Rockridge extensions
enabled. If volume management software is in use, the CD mounts
automatically when you insert it into the CD drive. Alternatively, you
can mount the CD as described in the following procedure.

If the CD is mounted incorrectly, some of the files cannot be read and
the installation fails with a corrupted directory. You must mount the
CD with Rockridge extensions enabled.

1. Log in and ensure that your user ID has root authority.

2. Complete the security setup described in|’Security on Linux and|
[UNIX systems” on page 58|

3. Create a CD mount point directory and grant read-only access to
all users:

mkdir /cdbroker
chmod 775 /cdbroker

where /cdbroker is the mount point.

4. Insert the CD that you want to access into the drive of the
computer on which you want to install one or more product
components.

5. Mount the CD by using the following command:
mount -F cdfs /dev/dsk/device /cdbroker

where /device is the CD device, for example /c0t0d0 and /cdbroker
is the mount point.

You are now ready to install the product that is supplied on this CD.

1. Log in and ensure that your user ID has root authority.

2. Complete the security setup described in [“Security on Linux and|
[UNIX systems” on page 58|

3. Create a CD mount point directory:
mkdir /cdbroker

where /cdbroker is the mount point.
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Solaris
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4. Insert the CD that you want to access into the drive of the

computer on which you want to install one or more product
components.

Run the following command:
mount -o ro -t 1509660 /dev/cdrom /cdbroker

where /dev/cdrom is the name of your CD device (for example,
/dev/hdc) and /cdbroker is the mount point.

You are now ready to install the product that is supplied on this CD.

N —

. Log in and ensure that your user ID has root authority.

. Complete the security setup described in [“Security on Linux and|

[UNIX systems” on page 58|

Insert the CD that you want to access into the drive of the
computer on which you want to install one or more product
components.

Enter the following command to check whether the Volume
Manager is running on your system:
/usr/bin/ps -ef | /bin/grep vold

If the Volume Manager is running, the CD is mounted on
/cdrom/vol_label automatically, where vol_label is the volume
label of the current CD; for example, wmb6_sol for Runtime Disk 1.

If the Volume Manager is not started, run the following
commands to mount the CD:

mkdir -p /cdbroker
mount -F hsfs -o ro /dev/dsk/cdrom /cdbroker

where /dev/dsk/cdrom is the CD location (for example, c0t0d0) and
/edbroker is the mount point directory.

Check where your CD is located by using the command iostat
-En. Alternatively, use the volcheck command to mount a CD
device automatically.

You are now ready to install the product that is supplied on this CD.
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Windows

1. Log on with a user ID that has Administrator authority, but is not
the Administrator ID.

2. Complete the security setup described in [“Security on Windows]
[systems” on page 60

3. Insert the CD that you want to access into the drive of the
computer on which you want to install one or more product
components.

You are now ready to install the product that is supplied on this CD.

Accessing CDs and DVDs on a remote system

If you want to install product components from a remote (server) CD or DVD,
complete this task. Always consult your operating system documentation for
exact details of this task.

If you want to perform more than one installation of one or more
components, you might find that a remote server setup provides some
performance benefits, particularly for the Message Broker Toolkit which is the
largest component. You might also find this method more convenient if you
want to run installations by using the silent interface.

If you want to install the Message Broker Toolkit by using the silent interface,
and you cannot install from DVD, you must copy the installation images onto
a disk drive, as described here, to avoid the requirement to swap CDs during
the process.

To enable a remote installation, you must complete tasks on both the server
(the computer on which the CD, DVD, or shared drive is mounted) and each
target system (on which you want to install the product). For details of the
commands used in these examples, refer to the operating system
documentation.

You can use these instructions if you want to install, from a server, other
products that are supplied with WebSphere Message Broker, for example DB2
Enterprise Server. However, you must check with the appropriate associated
product documentation to ensure that remote installation is supported.
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Setting up the server
You can either share the CD drive on the server, or copy the installation
images onto a disk and share the directory on that disk.

You can share a CD drive on Linux or UNIX with any other supported Linux
or UNIX system, but not with Windows. You can share a Windows CD drive
only with other Windows systems.

1.
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If you want to share a copy of the installation image, create the copy:
a. Create a directory on the server to store the installation images:

Linux and UNIX
Enter the following command:

mkdir /instbroker

where instbroker is the directory into which you copy
the product files.

Windows Enter the following command:
md m:\instbroker

where m is the drive on which you want to store the
installation images and instbroker is the directory on
that drive.

If you are creating directories for the Message Broker Toolkit on Linux
(x86 platform) or Windows, you must create all three disk
subdirectories in the same directory, for example:

/instbroker/diskl

/instbroker/disk2

/instbroker/disk3

where each subdirectory, for example diskl, is the root level of the
corresponding CD image.

This structure ensures that the installation program does not prompt
for location, and does not fail because it cannot find the right images.

Insert and mount the appropriate CD in the drive as described in
[ Accessing CDs and DVDs on the local system” on page 62| The
installation programs for the runtime components and the Message
Broker Toolkit are on separate CDs; insert the correct CD for the
components that you want to install from this server.

If you have inserted a runtime or toolkit CD on Windows and autrorun
is enabled, the Launchpad is invoked. When the initial window opens,
click Cancel to close it.



Accessing CDs and DVDs remotely

c. Copy the complete contents of the CD to the new directory.
Linux and UNIX

Windows

Enter the following command:

cp -rf /cdrom/. /instbroker

Enter the following command:
xcopy f:\*.* m:\instbroker /e

where f is the CD drive.

2. Grant users access to the drive that contains the product code. These
instructions are the same for a disk drive on which you have copied the
CD contents, and for the CD drive itself.

AIX

Either type smit and click Communications Applications
and Services > NFS > Network File System (NFS) > Add
a Directory to Exports List, or enter the fastpath command
smitty mknfsexp. Complete the fields as appropriate and
press Enter.

HP-UX and Linux

Solaris

Windows

Use the exportfs command. The example below gives all
users read-only access using NFS:

exportfs -i -0 ro /instbroker
exportfs -a

where /instbroker represents the CD drive or the directory
that contains the CD copy.

Use the share and exportfs commands. The example
below gives all users read-only access using NFS:

share -F nfs -o ro -d "Broker LAN server" /instbroker
exportfs -a

where "Broker LAN server” is an optional description and
/instbroker represents the server CD drive or directory
containing the CD copy.

Open Windows Explorer and right-click the drive that you
want to share. Click Sharing and follow the instructions
on the Properties dialog box.
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Setting up the target system

On Linux and UNIX systems, create a new directory on which to mount
the shared directory. Enter the following command:

1.

mkdir /remotebroker

where remotebroker is the name of the new directory.

Access the remote directory:

Linux and UNIX

Windows

Enter the following command:

mount server name:instbroker /remotebroker

where server name is the name of the server on which you
created the CD copy.

Connect to the appropriate drive and folder by using the
net use command at a command prompt on the target
system, for example:

net use x: \\server_name\instbroker

where x: is the required mapped drive on the target
system.

If your shared installation directory name contains spaces
(for example, Broker Image), enclose it in quotes.

If your server is protected, you might need to specify a
user ID and password on this command (see the Windows
online help for more information about net use).
Alternatively, use Windows Explorer or an alternative
method to map the shared resource to a drive letter.

You cannot enter a UNC path (\\server\drive) to access
the installation program; you must map the drive, as
shown, otherwise the Java process times out. If you cannot
map the drive, or choose not to map the drive, copy the
contents of the CD onto a local drive and install from that
drive. In addition, you cannot enter a UNC path when the
installation wizard requests a path as input; the wizard
cannot interpret a UNC path.

3. Change to the remote image directory. You are now ready to install the
product in that directory.
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Checking the kernel configuration on Linux and UNIX systems

WebSphere Message Broker has no specific requirements for kernel
configuration parameters, However, other products might require particular
settings. If you do not tune your kernel parameters to suit the products that
you have installed, you might see unexpected behavior or experience
performance deterioration.

1. Check the documented values for the following products:

* WebSphere MQ; see the topic "Kernel configuration" for your operating
system in the online [WebSphere MQ information center at:

publib.boulder.ibm.com/infocenter/wmqv6/v6r0/index.jsp

* DB2, if installed. If you are using Version 9.1, see the online
at:

publib.boulder.ibm.com/infocenter/db2Tuw/v9/index.jsp

If you are using Version 8, see the online [information center|at:

publib.boulder.ibm.com/infocenter/db21uw/v8/index.jsp

* Any other software that you have installed to work with WebSphere
Message Broker that provides documented values; for example, other
database suppliers.

2. Take the highest value for each parameter and compare it to the
corresponding value in your kernel configuration.

3. If the current value is lower than the highest documented value, update
the current setting by using the appropriate tool; for example, SAM on
HP-UX. If the current value is higher, leave it unchanged.

4. On Solaris, increase the maximum number of concurrent open file
descriptors on your system to at least 256.

5. If you have changed any kernel values, you might have to restart your
system for these changes to take effect. Check the documentation for your
operating system for further information about these parameters.
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Chapter 6. Choosing what to install

WebSphere Message Broker delivers three runtime components and the
Message Broker Toolkit. You can install one or more runtime components
(broker, Configuration Manager, and User Name Server) on all supported
operating systems. You can install the Message Broker Toolkit only on Linux
(x86 platform) and Windows.

Runtime components

On distributed systems, you can choose to install one or more
components. On z/0S, all the runtime components are installed; you
cannot choose to install a subset of components.

Broker

The broker is a set of execution processes that provides
message processing facilities that interact with a variety of
application clients that use both point-to-point and
publish/subscribe communications. The message flows that
you create are hosted by the broker. A broker can host many
message flows, in one or more execution groups, and can
support many clients.

You define how messages are received, processed, and
delivered to receiving applications or subscribers.

© Copyright IBM Corp. 2005, 2008

You can customize some message processing nodes in a
message flow with mappings, ESQL, Java, and XSL style
sheets.

You can create message models to define message structures
determined by C and COBOL data structures, industry
standards such as SWIFT or EDIFACT, and XML DTD or
schema.

You can develop user-defined extensions (nodes and
parsers) to support message processing options that are not
provided by the supplied nodes and parsers.

You can debug message flows and step through processing
to check paths and results.

You can use message flow aggregation to manage multiple
requests and responses that are generated by a single input
message.
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The broker creates and maintains state and local configuration
data in a database. You must install and initialize a suitable
database before you create a broker, although you can install

the broker component and the database in any order. For
information about supported databases, see

Configuration Manager

A Configuration Manager is an interface between the Message
Broker Toolkit and a set of one or more brokers, and controls
the resources in a broker domain. It maintains the
configuration details of the domain, and disseminates the
updates and additions that you make to that domain in the
Message Broker Toolkit.

The Configuration Manager creates and maintains the
configuration data for the domain in an internal repository.

User Name Server

A User Name Server is an optional component that provides
authentication for publish/subscribe environments by using
access control lists based on operating system definitions.
Install this component only if you want to restrict the
publish/subscribe activity of users or groups.

A single User Name Server to handle the publish/subscribe
authentication within a broker domain is typically sufficient; if
you have heavy publish/subscribe message traffic and a large
number of users, you might want to consider more than one
User Name Server. See the additional information about this
option in the information center.

If you are migrating from Version 5.0 or Version 6.0, and you
already have a User Name Server that provides
publish/subscribe authentication within your domain, you do
not need to install another one, because the User Name Server
is unchanged in function in Version 6.1.

You can install any combination of these components, and you can
install them more than once on any system. For more details about
how different installations can coexist, see |Chapter 2, “Coexistence

land migration,” on page 27|

For installation of runtime components, you can choose between a
typical installation and a custom installation. These are explained in

[Chapter 2, “Coexistence and migration,” on page 27
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Message Broker Toolkit

The Message Broker Toolkit is an integrated development
environment and graphical user interface that is based on the Eclipse
platform and the Rational framework.

Application developers work in separate instances of the Message
Broker Toolkit to develop message flows, message sets, and
user-defined nodes and parsers. You can access a shared repository
(for example, CVS) to store resources and make them accessible in a
secure manner to multiple users.

Administrators can connect the Message Broker Toolkit to one or more
Configuration Managers, and manage the broker domains through
those Configuration Managers, for example by deploying resources to
brokers, and starting and stopping resources.
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Chapter 7. Choosing an installation interface

Choose the interface that you want to use to install WebSphere Message
Broker from the following options:

+ On Windows only, [“The Windows Launchpad”]

* [‘Graphical interface” on page 76|

* [‘Console interface (runtime components only)” on page 76|

* [‘Silent interface” on page 77

Each interface has different advantages, which are discussed in the
appropriate sections. When you have chosen the interface that you want to
use, follow the installation instructions:

* [Chapter 8, “Installing with the Windows Launchpad,” on page 85|

* [Chapter 9, “Installing runtime components,” on page 97

* [Chapter 10, “Installing the Message Broker Toolkit,” on page 103

The same interfaces are also available for uninstallation tasks, which are
described in the information center.

The Windows Launchpad

On Windows, the Launchpad is the preferred and the default process for
installation. The Launchpad helps you through the installation process for
WebSphere Message Broker and the prerequisite products (for example, DB2
and WebSphere MQ) that are required for runtime components. You can either
install them individually by following the Launchpad prompts, or request that
the Launchpad installs your selected products for you, by using default
options.

From the Launchpad you can also view this book in PDF format, review the
readme file readme.html, and launch the Quick Tour (see |Chapter 11,|
[“Configuring and verifying your system,” on page 119|for further
information).

The Launchpad exists on the Windows DVD, and on every Windows CD from
which you might install product components or prerequisite products. If
autorun is enabled, the Launchpad starts automatically when you insert a CD
or DVD.
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Graphical interface

If you start the installation wizard with no options, it starts the graphical
interface (this interface is the default option). The wizard guides you through
the installation process with a series of pages that present options and default
values. You can accept the default values, or change them to suit your
environment and requirements.

The graphical interface provides the highest level of information and guidance
to help you complete an installation. Use this interface when you are
unfamiliar with the product, or if you want to monitor the installation
progress.

The name of the installation wizard for your operating system is listed in
[‘Installation wizard names” on page 82 for example, setupaix for AIX.

If you click Cancel before you start the installation process, you can exit the
setup. If you decide to exit, your system returns to the state that it was in
before the installation wizard was launched. However, if you cancel the
installation wizard after the installation has completed, and the final summary
page is displayed, your system is not restored to its previous state; the
installation wizard stops immediately. If you want to remove a program that
has been installed, you must use the uninstall program.

When you use the wizard, you might have to wait a few seconds to move to
the next page after clicking Next. Progress is not always displayed on all
pages. If you click Next twice, you might skip an entire page. To ensure that
the installer is progressing, you can monitor your CPU usage; CPU usage
increases greatly during installation.

Console interface (runtime components only)

The console interface is a character-based interface with which you interact in
a command window. It presents the same options as the graphical interface.

This interface is not available when you install the Message Broker Toolkit.

Use the console interface if you want a command-line interface rather than a
graphical interface. This interface is also suitable for users who use only the
keyboard to choose values and navigate through installation, and those with
screen reader software such as JAWS.

The name of the installation wizard for your operating system is listed in
[“Installation wizard names” on page 82)Specify the option -console to run
the console interface. For example, on AIX:

./setupaix -console
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To navigate through the installation, enter the following values:

Move to the next panel

Return to the previous panel

Cancel and terminate the install program
Redisplay the current screen

B 0N =

The default option is always displayed within brackets; for example, [1]. If
this default value is your required choice, press Enter to continue.

Silent interface

If you start a silent installation, the installation wizard runs without any
interaction; installation is completed with default options, or according to a
set of options that are defined in a response file.

Use the silent interface to run the process unattended for automated
installations over a large number of identical systems.

The silent interface does not provide any feedback to the caller; therefore, you
must check the installation log to determine whether the installation was
successful. The location of the installation log is given in[“Dealing with|
broblems during installation” on page 94| (runtime components) andl”Dealiné
with problems during installation” on page 115 (Message Broker Toolkit).

The name of the installation wizard for your operating system is listed in
[“Installation wizard names” on page 82

Silent installation of runtime components

You can run a silent installation with default settings, or with one or more
non-default values:

* With default settings, the installation wizard performs the following actions:
— Checks that prerequisite software is installed
— Installs to the default directory
— Installs all selectable features

Because the installation wizard checks for prerequisite software, the
program fails if the prerequisite software is not already installed. You can
override this check if you use a response file (described below), or if you
include the appropriate parameter with a non-default value on the
command invocation.

To run a default silent installation, specify the -silent option on the
installation command. For example, to install runtime components on Linux
(x86 platform), enter the following command:

./setuplinuxia32 -silent
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* With one or more non-default settings, the installation wizard applies the
options that you specify on the command, or reads a response file to
determine what actions to take.

You can create a response file that contains your non-default settings in
three ways:
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Edit the sample response file that is provided on the CD or DVD.

The file is /sample-scripts/install.opt on Linux and UNIX systems
and \sample-scripts\install.opt on Windows. It includes detailed
information about the options that you can change, and the values that
you must enter to change them.

Modify the response file to take one or more of the following actions:

You must update the following line to remove the comment character
at the start of the line. If you do not do this, your other options are
ignored.

# -W setupTypes.selectedSetypTypeld=

Remove the number sign (the character #):

-W setupTypes.selectedSetypTypeld=

Choose a custom installation (typical is the default option):
-W setupTypes.selectedSetupTypeld=custom

Install to a non-default directory.

Find the following line, remove the number signs, and insert your
chosen installation directory:

### -P installlocation=<value>
Choose which components to install.

For example, to exclude the Configuration Manager, find this line in
the response file:

# -P configManagerFeature.active=true

Change the line to read:

-P configManagerFeature.active=false

Specify whether the program is to check for prerequisite software.

Add one or both of the following lines to the file to instruct the
installation wizard to ignore the check for specific software:

# don't check for WebSphere MQ
-P mgPrerequisite.active=false

# don't check for Java Messaging
-P javaMessagingPrerequisite.active=false



Silent interface

— Record a response file that contains your installation preferences.

Run the graphical interface of the installation program from the
command line, specifying the option -record. Complete the installation
following the guidance in [‘Running a graphical installation” on page 99}
the response file content is recorded to reflect the choices that you made.
For example:

installer -options -record responsefile

where installer is the name of the installation wizard on your operating
system (listed in [“Installation wizard names” on page 82) and responsefile
is the fully qualified path and name of your response file. Specify a
directory that is different to the one that you specify as your installation
directory. On Windows, you must surround the path and name with
double quotes if it contains spaces.

Before you use the response file, check for the following line:
-W setupTypes.selectedSetupId=custom

Remove the value custom so that the line has the content shown below; if
you do not, a full installation is completed:

-W setupTypes.selectedSetupld=
Use the recorded file for subsequent installations, as shown below.

— Generate a template response file.
Run the graphical interface of the installation program from the
command line, specifying the option -template and the name of the file
that you want to record. Navigate through the installation following the
guidance in [“Running a graphical installation” on page 99} the response

file content is generated to reflect the choices that you made but
installation is not performed. For example:

installer -options -template responsefile

where installer is the name of the installation wizard on your operating
system (listed in [“Installation wizard names” on page 82) and responsefile
is the fully qualified path and name of your chosen response file. Specify
a directory that is different to the one that you specify as your
installation directory. On Windows, you must surround the path and
name with double quotes if it contains spaces.

Edit the template to change any of the options, then use the modified file
for subsequent installations, as shown below.

You can also record a response file, or generate a template file, by using the
console interface. Add the option -console to the commands shown above,
and follow the guidance in[“Running a console installation” on page 100/
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To run a silent installation that uses a response file called responsel.txt,
specify the -silent option and the fully qualified path and name of the file
on the installation command. For example, on Linux (x86 platform), enter

the following command:

./setuplinuxia32 -silent -options /userl/scripts/responsel.txt

The following table provides a summary of the options you can use with

response files.

Table 13. Options for silent installation of runtime components

Action

Invocation

The installation wizard performs a default
installation with no user interaction.

installer -silent

The installation wizard performs an
installation with input provided by the
response file.

installer -silent -options responsefile

The installation wizard generates a template
response for later modification and use but
performs no installation.

installer -options -template responsefile

The installation wizard presents the graphical
interface for installation with user input, and
records all specified options in a response
file.

installer -options -record responsefile

The installation wizard presents the console
interface for installation with user input, and
records all specified options in a response
file.

installer -options -record -console responsefile

Silent installation of the Message Broker Toolkit
You can run a silent installation with default settings, or with one or more

non-default values:

* With default settings, the installation wizard performs the following actions:
— Installs to the default directories
— Installs all supported locales

To run a default silent installation, enter the following command. If
Installation Manager is not already installed, it is installed before the
Message Broker Toolkit is installed.

Linux (x86 platform)

./install -nosplash --launcher.suppressErrors -silent -input mbtoolkit-silent.xml

Windows

install.exe -nosplash --launcher.suppressErrors -silent -input mbtoolkit-silent.xml
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* With one or more non-default settings, the installation wizard applies the
options that you specify in a response file to determine what actions to
take.

To create a response file that contains your non-default settings, start the
installation program and specify only the option -record, and the name and
path of the response file.

Complete an installation by using the graphical interface following the
guidance in|“Running a graphical installation” on page 105 the toolkit is
installed and the response file content is recorded to reflect the choices that
you make.

For example, on Linux (x86 platform), enter the following command to
record the response file:

install -record /userl/scripts/responsel.xml

where /userl/scripts/responsel.txt is the fully qualified path of your response
file.

To run a tailored silent installation, specify the recorded response file when
you start the installation program for subsequent installations. For example:

./install -nosplash --Tlauncher.suppressErrors -silent -input /userl/scripts/responsel.xml
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Installation wizard names

The installation wizard has a different name on each operating system. To
help you find these programs quickly, the names are shown in the table
below. Substitute this name where you see installer in the text.

Table 14. Installation wizard names

Operating system

Installation wizard name

AIX setupaix
HP-UX (Integrity platform) |setuphpia64
HP-UX (PA-RISC platform) |setuphp

Linux (POWER platform)

setuplinuxppc

Linux (x86 platform)

setuplinuxia32 (runtime components)
install (Installation Manager for Message Broker Toolkit)

Linux (x86-64 platform)

setuplinuxx64

Linux (zSeries platform)

setuplinux390

Solaris (SPARC platform)

setupsolaris

Solaris (x86-64 platform)

setupsolarisx64

Windows

setup.exe (runtime components)
install.exe' (Installation Manager for Message Broker Toolkit)

Notes:

1. You can also use installc.exe to start Installation Manager. This program
operates synchronously and does not return control to the command line
until the installation has completed.
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Part 3. Installation

This part of the book describes how you install WebSphere Message Broker.
The information here addresses installation of runtime components on
distributed systems. It also addresses installation of the Message Broker
Toolkit for all users.

Chapter 8, “Installing with the Windows Launchpad,” on page 85|

Chapter 9, “Installing runtime components,” on page 97

Chapter 10, “Installing the Message Broker Toolkit,” on page 103

If you are installing runtime components on z/OS, follow the instructions
provided in the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS.
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Chapter 8. Installing with the Windows Launchpad

On Windows only, use the Launchpad for additional help:

¢ To install the Message Broker Toolkit

* To install WebSphere Message Broker runtime components
¢ To install prerequisite products for the runtime components
* To upgrade runtime components to Version 6.1.0.2

The Launchpad uses the DVD or CDs to install and upgrade components; you
cannot use the Launchpad if you want to install or upgrade components from
update packages that you have downloaded from Passport Advantage. For
these alternative methods, and their potential advantages, see [Chapter 9)

“Installing runtime components,” on page 97 or [Chapter 10, “Installing the]

Message Broker Toolkit,” on page 103

— Multiple installations on a single computer
You can use the Launchpad to install only one instance of the product
components on a single computer. If you have selected and installed the
runtime or toolkit components, you cannot use the Launchpad to install
these components again in a different location.

To install additional instances, run the appropriate installation wizard
directly. See [Chapter 9, “Installing runtime components,” on page 97| or
[Chapter 10, “Installing the Message Broker Toolkit,” on page 103 for
instructions about how to complete these tasks.

The Launchpad also manages only one installation of DB2 and
WebSphere MQ on a single computer. Refer to the relevant product
documentation if you want to install multiple instances.
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Installation summary

This list summarizes the actions that you must take:

1.

Check the readme file readme.html for any updates to these installation

instructions. The readme file location is shown at the start of [Chapter 1,

[‘System requirements,” on page 3.|

Check that you have enough memory and disk space; refer to M
fand disk space” on page 5|

Decide whether you want to install from a server, or install locally on each

system. These choices are described in [“Accessing CDs and DVDs” on|

Start the Launchpad to install WebSphere Message Broker and its

prerequisite products. Full instructions are provided in [“Starting the|

[Windows Launchpad.”

When you have completed installation, see [Part 4, “After installation,” on|

page 117|for information about verifying your installation, and what you can
do next.

If you experience problems during installation, refer to

[problems during installation” on page 94.|

Starting the Windows Launchpad

When you insert the product media, the Launchpad starts automatically if
autorun is enabled. If autorun is not enabled, find and double-click the file
mgsilaunchpad.exe in the root directory of the CD or DVD, or type
mgsilaunchpad in a command window and press Enter. The Launchpad is
available on every CD or DVD from which product components or
prerequisite products can be installed.

On the first page, choose how to install WebSphere Message Broker and any
of its prerequisite products that you have not previously installed:

Express Installation installs the set of products that are required for a
minimum configuration of WebSphere Message Broker. The Launchpad
completes the installation of each prerequisite product with minimal input
by using default values where input is required. The Message Broker
Toolkit and runtime components are installed by using the graphical
interface.

Choose this option if you are not familiar with WebSphere Message Broker,
or its software requirements, or if you want a default installation of the
minimum set of software required for a broker domain configuration.

If you want to perform an Express Installation, see ['Express Installation” on|
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Advanced Installation displays a larger set of required and optional
products that you can install one by one. For each product that you select,
the Launchpad invokes the installation wizard graphical interface, and you
must provide all required input.

Choose this option if you are familiar with WebSphere Message Broker and
its software requirements, or if you want to install products individually
and specify your own values for any options during installation.

If you want to perform an Advanced Installation, see
[nstallation” on page 92

Access further information from the left pane:

Click Installation Guide to launch a PDF copy of this book in Acrobat®
reader.

Click Readme to view the readme file readme.html] in a new browser
window.

Click Quick Tour to take a tour around the product. See|Chapter 12

["What's next,” on page 127|for further information.

The Launchpad might have to search for an installation wizard for some of
your selections. If you are installing from DVD, all the required products can
be found, but if you are installing from CD, the program might be on another
CD, or might not be in the expected location. If necessary, the Launchpad
prompts you to take the appropriate action to find the file. shows, for
each supplied product, the program names and their locations on the CDs.

Table 15. Installation wizard names and locations

Product

Installation wizard

name Directory CD

WebSphere Eclipse
Platform V3.0'

IBM WebSphere
Eclipse Platform

\WebSphere_MQ_V6.0\Prereqs\IES\MSI Runtime Disk 2

V3.0.msi
WebSphere MQ' IBM WebSphere \WebSphere_MQ _V6.0\MSI Runtime Disk 2
MQ.msi
ODBC Drivers for |setup.exe \DB2_Runtime_Client V8.2 Runtime Disk 1
Apache Derby'
Message Broker setup.exe \ (root directory) Runtime Disk 1

runtime
components

Message Broker
Toolkit

install.exe \IBMInstallationManager? Toolkit Disk 1

DB2 Enterprise
Server'

DB2 Enterprise Runtime Disk 3

Server Edition.msi

\DB2_Enterprise_Server_V9.1\db2\Windows
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Table 15. Installation wizard names and locations (continued)

Installation wizard
Product name Directory CD
WebSphere MQ setup.exe \ (root directory) WebSphere MQ
Everyplace' Everyplace
supplemental
disk
Notes:

1. WebSphere Message Broker Trial Edition does not include these items. See
(Chapter 4, “Installation packages,” on page 41| for further information.

2. The Launchpad starts Installation Manager, which installs itself (if
required), and starts the Message Broker Toolkit installation.
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Express Installation

When the Launchpad starts, it displays the Express Installation page.

1.

Review the minimum set of products that are required for a default
configuration:

* WebSphere Eclipse Platform V3.0.1

* WebSphere MQ V6.0

* ODBC Drivers for Apache Derby

* WebSphere Message Broker V6.1.0.2 (runtime components)

* WebSphere Message Broker Toolkit V6.1.0.2

Check the initial installation status that is shown for each listed product:

* Required indicates that the product is not installed, and is one of the
products that is required for a minimum configuration, and its selection
is cleared.

* Pending indicates that the product must be installed to ensure the
successful operation of a minimum configuration broker domain. The
associated check box is selected to show that this product will be
installed.

* Installed indicates that the product is already installed at a level that is
supported by WebSphere Message Broker. The installed version is
shown and no check box is displayed.

* Partial Installation indicates that the product is installed, but not all
components that are required to ensure the successful operation of a
minimum configuration broker domain are present on the system. The
associated check box is selected to show that additional components will
be installed.

* Incorrect Level indicates that a level of the product that is not
supported by WebSphere Message Broker is installed on the system. Use
the Advanced Installation option to upgrade this product to a supported
level.

If an unsupported level of DB2 or WebSphere MQ is installed, you are
directed to run the installation of these products from the Advanced
Installation option, so that you are presented with the full interactive
graphical installation and you can respond to any decisions that must be
made during the upgrade.

Click the plus sign to the left of each listed product in turn. The
Launchpad displays more information about the product, which you can
use to decide if you want it installed. The additional information also
provides an estimate of the time taken to complete each product
installation.

Not all components of each required product are installed during an
Express Installation; for example, when the Launchpad installs WebSphere
MQ V6.0, it installs the server, WebSphere MQ Explorer, and the Java
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Messaging component. Check the details that are provided to ensure that
an Express Installation installs all the components that you want. If you
want additional components, use the Advanced Installation option.

WebSphere MQ Explorer requires the WebSphere Eclipse Platform to be
installed; when you select WebSphere MQ V6.0, the Eclipse Platform is
automatically selected.

The ODBC Dirivers for Apache Derby are used only to support access to
the default Derby embedded database which you can use for test and
evaluation purposes. If you already have a supported version of DB2
installed on this computer, you cannot install this component.

If you install the ODBC Drivers and use the embedded Derby database for
test or evaluation, install your chosen enterprise database product on
computers that you set up for production use, for which Derby is not
suitable.

If DB2 is your database of choice, install DB2 Enterprise Server Version 9.1
from the Advanced Installation. After installation of DB2, you must
register your license; this task is described in|[Appendix B, “Registering]
[your DB2 license,” on page 141

. If you do not want a listed product, clear the check box associated with

the product. Its status is changed to Required, because you cannot
configure and verify your installation without all of the listed products.
However, you can complete installation of the remaining products, and
install other required products at a later time.

If you are installing WebSphere Message Broker Trial Edition, clear the
selections for WebSphere MQ, the Eclipse platform, and the ODBC Drivers
for Apache Derby. These products are not supplied with the Trial Edition.
You must obtain prerequisite software from other sources to support the
WebSphere Message Broker Trial Edition. See [Chapter 4, “Installation|
[packages,” on page 41| for more information.

. Click Launch Express Installation for WebSphere Message Broker.

If you have cleared one or more of the required products, you are asked to
confirm your choices.

The Launchpad installs the products that you have selected in the order
shown, prompting you to insert different CDs, if required. You cannot
make any changes on the Express Installation page after you have started
the installation process. When the Launchpad starts each installation, it
updates status from Pending to In Progress.

* If you have selected WebSphere Eclipse Platform V3.0.1, the Launchpad
starts the installation wizard silent interface; default values are used for
all options. A progress bar is displayed.

 If you have selected WebSphere MQ V6.0, the Launchpad starts the
installation wizard silent interface; default values are used for all
options. A progress bar is displayed so that you can check on progress.
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* If you have selected ODBC Drivers for Apache Derby, the Launchpad
starts the installation wizard silent interface; default values are used for
all options. A progress bar is displayed. During installation, you see the
product name DB2 Run-Time Client on the progress bar; this name is
also shown in Add/Remove Programs when the installation is complete.

* If you have selected WebSphere Message Broker V6.1.0.2 (runtime
components), the Launchpad invokes the installation wizard graphical
interface. You must supply the input that is required by the installation
wizard.

The installation wizard guides you through a series of pages where you
can make choices about where to install the components, and which
components you want to install.

You must also read and accept the Software License Agreement that is
displayed. This agreement covers your use of both WebSphere MQ
Version 6.0 and the ODBC Drivers for Apache Derby, if you have chosen
to install one or both of these products. These products are licensed for
use with WebSphere Message Broker only, and must not be used for
other purposes.

When you are asked if you want to open a command console when the
wizard terminates, select Yes. A console window opens, initialized with
the correct environment for command invocation. The command console
is explained in [“Setting the environment for an installation” on page 32/

* If you have selected the Message Broker Toolkit, the Launchpad starts
the installation wizard graphical interface.
The process is controlled by Installation Manager, which installs itself if

it is not already installed on this computer. For further information
about Installation Manager, see [‘IBM Installation Manager” on page 21.|

The installation wizard guides you through a series of pages where you
can make choices about where to install the component, which package
group to install it in, and what language support you want to install.
You must also accept the Software License Agreement that is displayed.
You must supply all input that is required by the installation wizard.

If you want to launch the Message Broker Toolkit when its installation
wizard has completed, select Message Broker Toolkit in the list of
installed products that is displayed on the completion page. When you
click Finish, the wizard ends and returns control to the Launchpad, and
the Message Broker Toolkit is started.

The status of each product changes to Installed when the Launchpad has
completed its installation.

When the Launchpad has installed all your selected products, it returns
control to the Express Installation page.

6. Click Exit Launchpad to end the program.
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When the Launchpad starts, it displays the Express Installation page.

1.
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Click Advanced Installation in the left pane to display the Advanced
Installation page. The Launchpad displays a list of the following products:

* WebSphere Eclipse Platform V3.0.1

* WebSphere MQ V6.0

* ODBC Drivers for Apache Derby

* WebSphere Message Broker V6.1.0.2 (runtime components)

* WebSphere Message Broker Toolkit V6.1.0.2

* DB2 Enterprise Server Version 9.1 (optional)

* Oracle (optional)

* Sybase (optional)

* Microsoft SQL Server 2000 (optional)

Check the initial installation status that is shown for each listed product:

e If the product is not installed, and is one of those required for a
minimum configuration, the status is Required.

e If the product is not installed, and it is an optional product, the status is
Not Installed.

* If the product is already installed, and it is a version that is supported
by WebSphere Message Broker (or later), the status is Installed.

* If an earlier version of the product that is not supported by WebSphere

Message Broker is installed on the system, the status is Incorrect Level.
Install the supported version from this page.

If a product is found but has not had a complete installation, the status
is Partial Installation. Install the full product from this page.

For example, you might previously have completed a typical installation

of WebSphere MQ, which does not include the Java Messaging
component, which the broker requires, therefore your installation is
shown as partially complete.

Click the plus sign to the left of a product to expand the information that
is displayed about the product.

If you want to install this product, and it is an IBM product that is not
already installed, click Install in the expanded information to launch the
product installation.

The Launchpad launches the installation wizard graphical interface. You
must supply the input required by the installation wizard, including, if
appropriate, which components you want to install.

If you are installing WebSphere Message Broker Trial Edition, you can
install only the runtime components and the Message Broker Toolkit. No
other IBM products are available with the Trial Edition. You must obtain
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prerequisite software from other sources to support the Trial Edition. See
[Chapter 4, “Installation packages,” on page 41| for more information.

The ODBC Drivers for Apache Derby are used only to support access to
the default Derby embedded database which you can use for test and
evaluation purposes. If you already have a supported version of DB2
installed on this computer, you cannot install this component.

Start each required installation in the order of your choice. Each
installation is performed separately, and the Launchpad prohibits any
other action until the current installation has completed. It also minimizes
its window while the installation is in progress, and restores itself to focus
when the installation is complete.

If the Launchpad cannot find an installation wizard because it is on
another CD, or is not in the expected location, it prompts you to take the
appropriate action to find the file. See [Table 15 on page 87| for details of
installation program names and locations.

When the Launchpad has completed the installation, it updates the
product status to Installed.

If you install the ODBC Drivers and use the embedded Derby database for
test or evaluation, install your chosen enterprise database product on
computers that you set up for production use, for which Derby is not
suitable. If DB2 is your database of choice, install DB2 Enterprise Server
Version 9.1. If you do so, you must register your license for this product;
this task is described in |[Appendix B, “Registering your DB2 license,” on|
|n; e 141.

If you want to use Oracle, Sybase, or SQL Server, but the product that you
have installed is not at the required supported version, or it is not
installed, you must acquire and install the product yourself; the
Launchpad does not provide this option. If Oracle is installed, you must
check that the installed version is supported, because the Launchpad
cannot determine the version of the installed product. Supported databases
are shown in|Table 6 on page 14}

Repeat the previous step for each product that you want to install.

When you install WebSphere Message Broker runtime components or the
Message Broker Toolkit, the installation wizards guide you through a
series of pages where you can make choices about where to install the
components, which components you want to install, and (for the Message
Broker Toolkit only) what language support you want to be installed. You
must also read and accept the Software License Agreement that is
displayed.

During the installation of runtime components, you are asked whether you
want to open a command console when the wizard terminates. If you do,
select Yes. A console window opens, initialized with the correct
environment for command invocation. The command console is described
in [“Setting the environment for an installation” on page 32|
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If you want to launch the Message Broker Toolkit when its installation
wizard has completed, select Message Broker Toolkit in the list of
installed products that is displayed on the completion page. When you
click Finish, the wizard ends and the Message Broker Toolkit is started.

6. When an installation has completed, and before you start another
installation, you can click Refresh Advanced Installation List to check the
status of each product listed.

7. When you have completed the installation of all your chosen products,
click Exit Launchpad to end the program.

Dealing with problems during installation

The Launchpad waits for a return code from each installation wizard that it
initiates. If the return code indicates that the installation has failed, the
Launchpad reports the error and refers you to the documentation for the
product that has failed. Most installation wizards roll back from the point of
the error and return your system to the state it was in before the failed
attempt, and you can therefore try again after you have corrected the error.

If the Launchpad has already installed one or more products successfully
before an error occurred, it does not roll back these installations. When you
restart the Launchpad, the status of installed products reflects successful
installations from the previous invocation.

If a failure occurs:

 If you have chosen an Express Installation, you must either correct the error
and restart the Launchpad, or return to the Express Installation page and
deselect the product that failed.

* If you have chosen an Advanced Installation, you can continue to install
other products and address any reported errors at a later time.

If you are unable to install a product:

* Refer to the readme file readme.html for any late changes to the installation
instructions.

* If Message Broker runtime components fail to install, check the contents of
the installation log file mqsi6_install.Tlog, stored in your home directory.

* If the Message Broker Toolkit fails to install, check the contents of the
installation log file YYYYMMDD_TIME.xml, where YYYYMMDD_TIME is the
date and time of installation. The file is stored in the directory
/var/ibm/InstallationManager/uninstall/logs on Linux or
%ALLUSERSPROFILE%\Application Data\IBM\Installation Manager\logs on
Windows (%ALLUSERSPROFILE% is the environment variable that defines the
working directory; the default value is C:\Documents and Settings\Al1
Users but this setting might have a different value on your computer.)
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 If WebSphere MQ fails to install, check the contents of
MQV6_install.date_time.log stored in the temp directory of your home
directory.

* If the ODBC Drivers for Apache Derby fail to install, check the contents of
the installation log file \DB2LOG\db2.10g stored in your home directory.

 If DB2 fails to install, check the contents of db2diag.log and other logs
created during the installation of this product. For details of location and
possible content, see the DB2 documentation.

+ Review the problem scenarios described in|Appendix A, “Installation|
[problems,” on page 137 and follow the guidance given.

If you are still unable to resolve the problem, contact your IBM Support
Center.
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Chapter 9. Installing runtime components

This chapter describes the tasks that you must complete to install one or more
runtime components on all supported operating systems.

If you are installing runtime components on Windows, you can use the
Launchpad to complete this task; see|Chapter 8, “Installing with the Windows|
[Launchpad,” on page 85)

If you have already installed runtime components at V6.1.0.0 or V6.1.0.1 on
this computer, and you want to apply the update to V6.1.0.2, follow the
instructions in the section Installing > Applying service in the information
center in your existing installation.

If you want to install only the Message Broker Toolkit, see [Chapter 10}
[“Installing the Message Broker Toolkit,” on page 103

Installation summary

This list summarizes the actions that you must take:

1. Check the readme file readme.html for any updates to these installation
instructions. The readme file location is shown at the start of
[‘System requirements,” on page 3.|

2. Check that you have enough memory and disk space; refer to
fand disk space” on page 5/

3. If you do not already have WebSphere MQ installed, install it before you
install the runtime components.

Although you can install WebSphere MQ after you have installed runtime
components, the installation wizard checks that you have the supported
level of WebSphere MQ, or later, installed. If this check fails when you are
using the graphical or console interface, the installation wizard displays a
warning that lists potential problems. If you decide to continue, you must
complete the installation of WebSphere MQ before you create or start any
WebSphere Message Broker runtime components.

If you start the installation silent interface, the check for WebSphere MQ
fails. If you have not modified the default behavior by specifying a
tailored response file, the wizard terminates without taking any further
action. If you have modified the response file to ignore this check, the
installation wizard continues.

4. Decide if you want to install from a server, or to install locally on each
system. These choices are described in [“Accessing CDs and DVDs” on|
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for both CDs or DVDs, and images that you have downloaded
from Passport Advantage (if you are registered with the scheme). The
instructions here do not differentiate between CDs and downloaded
images; their behavior is the same.

5. Decide which installation interface you want to use. The alternatives are
explained in [Chapter 7, “Choosing an installation interface,” on page 75|

6. Follow the installation instructions provided in [‘Running a graphicall
installation” on page 99 )/“Running a console installation” on page 100/ or
‘Running a silent installation” on page 101]

When you start the installation wizard, it checks your system locale
setting. If the locale setting is supported (listed in [Chapter 3, “Nationall
language support,” on page 37), the wizard continues in this locale. If the
current setting is not supported, the wizard displays a dialog box, and you
must choose from the list of supported languages. This language is used
for installation only, and does not affect other processes on your computer.

If the directory that you specify for installation already contains a previous
version of WebSphere Message Broker, for example Version 6.0.0.3, the
installation wizard prevents you from installing Version 6.1.0.0 in this
location. You must specify a different location. You can then migrate
components to Version 6.1 from the previous version when appropriate.

If you are installing a broker, a database is required. The installation
wizard completes even if a supported database is not present on this
system, but you must install one before you can use the broker. For further
information about software requirements, see [“Software requirements” on|

When you have completed installation, see |Part 4, “ After installation,” onl
page 117|for information about verifying your installation, and what you can

do next.

If you install one or more runtime components on Windows, the Start menu
is updated. Detailed updates are described in the information center.

If you experience problems during installation, refer to

[problems during installation” on page 101,

98 Installation Guide



Installing runtime components

Running a graphical installation
To perform a graphical installation:
1. Start the installation wizard graphical interface:
* For local access, load the product CD or DVD.

Windows

— If autorun is enabled, the Launchpad is started immediately.
To use the Launchpad, see|Chapter 8, “Installing with the]
[Windows Launchpad,” on page 85 To cancel the Launchpad,
click Exit Launchpad.

— In Windows Explorer, navigate to the root directory of the
CD. Locate the wizard: its name is defined in |[“Installation
[wizard names” on page 82.|Double-click the wizard to start
it.

— Open a command prompt and navigate to the root directory

of the CD. Type the program name with no options, and
press Enter.

Linux Open a command prompt and navigate to the root directory of
the CD. Type the program name with no options, and press
Enter.

¢ For remote access, access the remote CD drive or network drive on
which the product media is available. Find the program file that you
want on the CD or mapped drive and start it as described above.

2. When the wizard starts, navigate through the windows and provide input
when requested. For example, you are asked to specify where to install the
components, and which components you want to install. You must also
read and accept the Software License Agreement.

3. When the summary window is displayed, check your choices and click
Next to complete installation. A progress bar is displayed so that you can
check on progress.
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Running a console installation

100

To perform a console installation:

1. Locate the installation wizard in the root directory of the local CD or
remote CD or network drive. The wizard name for your operating system
is listed in [“Installation wizard names” on page 82|

2. Enter the following command at a command prompt for default
invocation:

installer -console

If you start the installation from a directory other than the one in which
the wizard exists, include the absolute or relative path with the command
name.

3. When the wizard starts, follow the prompts given and provide input when
requested. For example, you are asked to specify where to install the
components, and which components you want to install. You must also
read and accept the Software License Agreement that is displayed.

4. Check and confirm your choices when asked to do so, and enter 1 to
complete installation.

If you are installing a broker, a database is required. The installation wizard
completes even if a supported database is not present on this system, but you
must install one before you can use the broker. For further information about
database requirements, see [“Databases” on page 12|
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Running a silent installation

To perform a silent installation:

1.

Locate the installation wizard in the setup directory of the local CD or
DVD or remote CD or network drive. The wizard name for your operating
system is listed in [“Installation wizard names” on page 82.|

Enter the following command at a command prompt for a typical
installation with all default settings.

If you start the installation from a directory other than the one in which
the wizard exists, include the absolute or relative path with the command
name.

Linux and UNIX
installer -silent

Windows Start the installation wizard within a start
command with parameter /w to ensure
that the installation completes before it
returns to the command prompt:
start /w setup.exe -silent

If you want to specify non-default settings, include a response file on the

invocation. You must specify a response file, for example, if you want to

install Version 6.1.0.0 in a customized location.

For more details of how to use response files, how to create response files,

and how to edit them to define your requirements, see |”Silent installation|

fof runtime components” on page 77/

The installation wizard completes without any user interaction.

Dealing with problems during installation

If you have problems during installation:

Refer to the readme file readme.html for any late changes to the installation
instructions.

Check the contents of the installation log mqsi6_install.log, stored in your
home directory.

Review the problem scenarios described in{Appendix A, “Installation|
[problems,” on page 137 and follow the guidance given.

If you are still unable to resolve the problem, contact your IBM Support
Center.

Chapter 9. Installing runtime components 101



102 Installation Guide



Chapter 10. Installing the Message Broker Toolkit

This chapter describes the tasks that you must complete to install the Message
Broker Toolkit on Linux (x86 platform) or Windows operating systems.

If you are installing the Message Broker Toolkit on Windows, you can use the
Launchpad to complete this task; see|Chapter 8, “Installing with the Windows|
[Launchpad,” on page 85)

If you have already installed Message Broker Toolkit V6.1.0.0 or V6.1.0.1 on
this computer, and you want to apply the update to V6.1.0.2, follow the
instructions in [“Upgrading the Message Broker Toolkit” on page 110.|

If you want to install only runtime components, see [Chapter 9, “Installing|
fruntime components,” on page 97/

Installation summary

This list identifies the choices that you have for installing the Message Broker
Toolkit, and the actions that you must take to complete your chosen task:
1. Check the readme file readme.html for any updates to these installation

instructions. The readme file location is shown at the start of |[Chapter 1,
[‘System requirements,” on page 3.|

2. Check that you have enough memory and disk space; refer to
fand disk space” on page 5/

3. Decide how you want to run the installation. Choose from the following
methods:

* Insert the media into the appropriate drive and access the installation
wizard directly.

* Copy the media contents to disk and install from the copy.

* Download the electronic media images from Passport Advantage (if you
are registered with this scheme), and install from the local images.

If you set up a remote server for any of these options, users on different

systems can access the same images. You can also create a tailored

response file so that all your users can complete a silent installation.

4. If any Rational products are running, stop or close them before you start
the installation.
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5. Complete the installation:

a. Decide whether you want to install from a server, or install locally on
each system. These choices are described in [‘Accessing CDs and|
[DVDs” on page 62]

b. Decide which installation interface you want to use. The alternatives

are explained in |[Chapter 7, “Choosing an installation interface,” on|
(The console interface is not supported by the Message Broker
Toolkit installation wizard.)

c. Follow the installation instructions provided in [“Installing from CD o1
The instructions do not differentiate between CDs, DVDs, and
downloaded images; their behavior is the same.

The installation of the Message Broker Toolkit is controlled by
Installation Manager. If Installation Manager is not already installed on
the computer, it installs itself and the Message Broker Toolkit.

When you have completed installation, see [Part 4, “After installation,” on|
page 117|for information about verifying your installation, and what you can

do next.

When you install the Message Broker Toolkit on Windows, the Start menu is
updated. When you install the Message Broker Toolkit on Linux (x86
platform), the main menu is updated. Detailed updates are described in the
information center.

If you experience problems during installation, refer to

[problems during installation” on page 115

Installing from CD or DVD

104

This section provides instructions for installing directly from CD or DVD. You
can also follow these instructions if you have copied the contents of the CDs
or DVD to disk, or if you have downloaded electronic images from Passport
Advantage; the task is identical except where specified otherwise.

If you choose to use CDs, you might find it more convenient to copy the
content of the CDs to a hard disk, and install from the copy, because the
installation wizard can continue unattended and does not require your
attention to swap CDs when requested. If you make CD copies, ensure that
you create the directory structure correctly; if you do not, the process might
fail. Follow the instructions in [“Setting up CD copies on disk” on page 109)
then continue with the appropriate section below.

When you start the installation wizard, it checks your system locale setting. If
the locale setting is supported (listed in [Chapter 3, “National language
lsupport,” on page 37), the wizard continues in this locale. If the current
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setting is not supported, the wizard continues in US English. This language is
used for installation only, and does not affect other processes on your
computer.

If you install the Message Broker Toolkit directly from CD on Linux (x86
platform), invoke the wizard from a location other than the mount point itself.
If you do not do so, you cannot change CDs because the CD drive is locked.
For example, if your mount point is /media/dvd/, invoke the wizard from
another location with the following command:

/media/dvd/IBMInstallationManager/install

Install the Message Broker Toolkit with your chosen installation interface:

‘Running a graphical installation”|

‘Running a silent installation” on page 108|

Running a graphical installation
To perform a graphical installation:

1.

Start the installation wizard graphical interface:

* To install directly from CD or DVD, load the media in the appropriate
drive.

Windows

— If autorun is enabled, the Launchpad is immediately started.
To use the Launchpad, see[Chapter 8, “Installing with the|
[Windows Launchpad,” on page 85]To cancel the Launchpad,
click Exit Launchpad.

— In Windows Explorer, navigate to the
\IBMInstallationManager directory of the CD. Locate the
wizard: its name is defined in [“Installation wizard names” on|
Double-click the wizard to start it.

— Open a command prompt and navigate to the
\IBMInstallationManager directory of the CD. Type the
program name with no options, and press Enter.

Linux Open a command prompt and navigate to the
/IBMInstallationManager directory of the CD. Type the program
name (defined in[“Installation wizard names” on page 82) with
no options, and press Enter.

* To install from local downloaded images, or copies of the media,
navigate to the location, find the installation file, and invoke it as
described above.

¢ To install from a remote server, access the remote CD or DVD drive, or
network drive, on which the product images are available. Find the
program file that you want on the CD or network drive, and invoke it
as described above.

Chapter 10. Installing the Message Broker Toolkit 105



Installing from CD or DVD

106

 If you prefer, you can run the batch file installToolkit.sh (on Linux)
or installToolkit.bat (on Windows) to start the installation wizard
graphical interface. The files are in the root directory of disk 1.

Installation Manager starts and the Install Packages window opens.

. The installation wizard is preconfigured to install both Installation

Manager and the Message Broker Toolkit, therefore the Message Broker
Toolkit packages are already selected in this window. If Installation
Manager has not been installed on this computer, its packages are also
selected. You cannot clear Installation Manager selections. Click Next to
continue. The Software License Agreement window opens.

. Read the license agreement, select I accept the terms in the license

agreements, and click Next. If you do not accept the license, the
installation wizard ends.

If you have not installed Installation Manager on this computer, or if you
have installed Installation Manager, but have not yet installed any product
that is managed by Installation Manager, the Shared Directory window
opens; continue with step EI If Installation Manager is already installed,
The Package group directory window opens; continue with step

. Specify the location of the shared resources directory. The default location

is displayed:
* Linux (x86 platform): /opt/IBM/SDP70Shared
e Windows: C:\Program Files\IBM\SDP70Shared

Type over the default location, or click Browse, to specify a different
location.

The shared resources directory must not contain another installation of
Message Broker Toolkit, or other files or products; you must specify a new
directory in this field.

If Installation Manager is not yet installed, you must also specify its
installation directory. The default location is displayed:

* Linux (x86 platform): /opt/IBM/InstallationManager

* Windows: C:\Program Files\IBM\InstallationManager

Type over the default location, or click Browse, to specify a different
location.

Click Next. The Package group directory window opens.

. Specify the package group into which you want to install Message Broker

Toolkit. If you have not installed Message Broker Toolkit (or another
related product) on this computer, the option Create a new package group
is selected automatically and the default values are displayed:

* Package group name: IBM Software Development Platform

* Installation directory:
— Linux (x86 platform): /opt/IBM/WMBT610
— Windows: C:\Program Files\IBM\WMBT610
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Type over the default location, or click Browse, to specify a different
location.

The package group installation directory must not contain another
installation of Message Broker Toolkit, shared resources, or other files or
products; you must specify a new directory in this field.

If you have previously installed another product that is managed by
Installation Manager, you can install Message Broker Toolkit into an
existing package group, or create a new one. Select the correct option for
the action that you want to complete. If you install into an existing
package group, the package group installation directory is already
finalized; you cannot change it.

This window displays the current setting of the shared resources directory
for information.

Click Next to continue. The Language Selection window opens.

. If you want to use the Message Broker Toolkit in a locale other than US
English, select additional support from the list presented. English is
always selected and installed; you cannot clear this selection. If you select
one or more alternative locales, documentation and properties files for all
supported languages are installed. Click Next to continue. The Summary
window opens.

. Check your choices and click Back if you want to make any changes to
your responses on any of the previous windows. This window displays
guidance information for the space required for the packages that you are
about to install and indicates that your disk has sufficient space.

Click Next to start installation. The Install Progress window opens.

. The features that you are installing, their associated directories, and the
locales that you have selected, are displayed for information. A progress
bar is displayed so that you can check the status of the installation. When
installation has finished, the Completion window opens.

. The wizard displays an indication of success or failure, and lists the
products and options that have been installed. Click View Log File to
check the results of the installation.

On Windows only you can indicate that you want the Message Broker
Toolkit to be launched when you click Finish to close the wizard. This
option is not available on Linux (x86 platform), because you might want to
complete verification logged on as a different user ID that does not have
root authority.
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If you do not choose to install optional locales at this time, you can install
them later:

* On Linux (x86 platform), navigate to the /eclipse directory within the
Installation Manager installation directory, and start the Installation
Manager program IBMIM.

(You cannot use the main menu entries unless you are logged on as root;
the menu item does not provide an option to become root, and root
authority is required for all installation tasks.)

* On Windows, click Start > Programs > IBM Installation Manager > IBM
Installation Manager to launch Installation Manager, and click Modify
Packages to change your installation.

If you prefer to use the command line, navigate to the \eclipse directory
within the Installation Manager installation directory, and start the
Installation Manager program IBMIM.exe.

Running a silent installation

You cannot install the Message Broker Toolkit directly from CD if you use the
silent interface, because you are required to swap CDs when prompted.
Therefore, for a silent installation, you must either install from DVD, or copy
the CD images on to a local or remote drive. For more information about
copying CD images, see [‘Setting up CD copies on disk” on page 109

To perform a silent installation:

1. Locate the installation wizard in the IBMInstallationManager directory of
the local CD or DVD or remote CD or network drive. The wizard name
fo.r your operating system is listed in [“Installation wizard names” on page|

2. Enter the following command at a command prompt for an installation
with all default settings.

Linux (x86 platform)

./install -nosplash --launcher.suppressErrors -input mbtoolkit-silent.xml -silent
Windows

install.exe -nosplash --launcher.suppressErrors -input mbtoolkit-silent.xml -silent
where mbtoolkit-silent.xml is the name of the response file that contains
all the default settings for installation.

If you want to specify non-default settings, include a different response file
on the invocation. To create a different response file, complete the first
installation by using the graphical interface, specifying the -record option.
The installation wizard records a response file that includes all your
chosen selections. For more information about how to record and use

resi onse files, see [“Silent installation of the Message Broker Toolkit” on|
page 80.
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If you prefer, you can install the Message Broker Toolkit by using the
batch files installToolkit-silent.sh or installToolkit.bat which use
the response file mbtoolkit-silent.xml. The batch files are in the root
directory of disk 1.

3. When the wizard starts, it installs Installation Manager (if it is not already
installed), then installs the Message Broker Toolkit by using default values,
or a response file, if specified.

4. The installation wizard runs to completion. Check the log for success or
failure of the installation process.

Setting up CD copies on disk

If you want to copy the contents of the installation CDs on Linux (x86
platform) or Windows to disk, you must create all three disk subdirectories in
the same directory, for example:

/instbroker/diskl

/instbroker/disk2
/instbroker/disk3

where each subdirectory, for example diskl, is the root level of the
corresponding CD image. Copy the appropriate CD contents to each directory.

This structure ensures that the installation wizard does not prompt for

location and wait for input, and does not fail because it cannot find the right
images or files.
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Message Broker Toolkit V6.1.0.2 is integrated with Installation Manager V1.1.1,
which is later than the version that supports Message Broker Toolkit V6.1.0.0
and V6.1.0.1.

If you have already installed the Message Broker Toolkit V6.1.0.0 or V6.1.0.1,
and you now want to upgrade one or more installations to V6.1.0.2, you can
either refresh the whole Message Broker Toolkit component to V6.1.0.2, or
apply only the updates.

If you refresh the whole component, Installation Manager is updated to V1.1.1
before the Message Broker Toolkit is refreshed. If you apply only the updates,
you must apply the update to Installation Manager before you can complete
the update for the Message Broker Toolkit.

You can continue to run Message Broker Toolkit V6.1.0.0 and V6.1.0.1 with the
updated Installation Manager, therefore you can update Installation Manager
on computers on which you want to continue to run earlier versions of the
toolkit, if that is appropriate in your environment.

If you have other Rational products installed on this computer, you can
upgrade Installation Manager to V1.1.1; this version is backward compatible,
and supports earlier versions of other Rational products.

Upgrade your current installation to V6.1.0.2 by using update packages that
are available from the Web, or by using the physical media or electronic
images.

Update packages from the Web

These options install only the fixes for both Installation Manager V1.1.1 and
Message Broker Toolkit V6.1.0.2.

Updating your installation on computers that have access to the Internet
Apply the fixes directly from update packages that are available on
the Web.

1. Close all Rational programs that are running on your computer,
including the Message Broker Toolkit.
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2. Start Installation Manager by using one of the following two

methods:
a. From the Linux main menu or the Windows Start menu:

* On Linux, you can use this option only if you are logged in
as root. If you have logged in as another user, you cannot
use the main menu links, even if you become root.

— On Red Hat, click System > IBM Installation Manager.

— On SUSE, click System Tools > IBM Installation
Manager.

* On Windows, click Start Programs > IBM Installation
Manager > IBM Installation Manager.

b. From the command line:

Navigate to the eclipse subdirectory in the directory in which
Installation Manager is installed and run the following
command:

e IBMIM
* IBMIM.exe

The initial window opens.

. Click Update Packages. Installation Manager automatically finds

the update for V1.1.1 and displays a message; click Yes to continue
the update.

The update might take a few minutes to complete, depending on
network traffic, and the speed of your connection.

If you click No to cancel this update, you cannot install the update
to the Message Broker Toolkit at this time, because that update
depends on the updated version of Installation Manager.

. When the update has completed, a confirmation message is

displayed. Click OK to restart Installation Manager. The initial
window opens.

. Click Update Packages. The Update Packages window opens.

Select the package group in which you have installed Message
Broker Toolkit. The list of products installed in this package group
is displayed.

. Click Next; Installation Manager searches the Web update site and

displays a list of available updates for the products and features
that you have installed in the selected package group.

Initially, Show recommended (below the list) is selected, and the
latest updates only are shown. (Updates are cumulative, therefore
you need only apply the latest fixes.)

. Select the updates that you want to apply and click Update.

Follow any prompts that are displayed; the updates are applied.
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8.
9.

Click OK to return to the Installation Manager initial panel.
Click File > Exit to close Installation Manager.

Updating your installation on computers that do not have access to the
Internet
Download the fixes from the Web to create local copies, then apply
those fixes to other computers in your broker domain.

Installation Guide

To download the fixes on a computer that has access to the Internet:

1.

Access the WebSphere Message Broker [Recommended Fixes Web
site:

www. ibm.com/support/docview.wss?uid=swg27006041

Click IBM WebSphere Message Broker v6.1, then click Toolkit in
the table of fixes. Recommended fixes for the Message Broker
Toolkit are displayed for all versions; click Version 6.1.

Look for the fix for V6.1.0.2 in the table; its status indicates that it
is recommended. Click Information and download for this fix.
The download and installation instructions, and details about
changes made in this version, are displayed.

Scroll down the page to find the Prerequisites section, then click
IM 1.1.1 release and download.

Scroll down the page to find Download package, and download
the file im-1.1.1.zip to a temporary directory; for example,
C:\temp on Windows.

The package might take a few minutes to download, depending
on network traffic, and the speed of your connection.

Return to the page that contains the download and installation
instructions for the fixes for V6.1.0.2. Scroll down the page to find
Download package, then click the HTTP link to download file
MB6100_6102.z1p into a temporary directory. You can use the
directory you used for the IM 1.1.1 fix download package, or
specify a different one. The package might take a few minutes to
download.

Extract the compressed file im-1.1.1.zip into an appropriate
directory; for example, on Windows you might choose directory
C:\IMI111_fix.

Extract the compressed file MB6100_6102.z1ip into the same or
another directory; for example, on Windows you might choose
directory C:\V6102_fix.


http://www.ibm.com/support/docview.wss?uid=swg27006041
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To apply the fixes on other computers:

1. Close all Rational programs that are running on your computer,
including the Message Broker Toolkit.

2. Start Installation Manager by following the previous instructions
in this section, and click File > Preferences.

3. On the Preferences window, click Repositories, then click Add
Repository. Click Browse and navigate to the directory in which
you extracted the Installation Manager update package. Select the
file respository.config and click OK.

4. Select Search service repositories during installation and
updates and click OK.

5. Click Update Packages. Installation Manager automatically finds
the update for V1.1.1 and displays a message that asks if you
want to continue; click Yes.

When the update has completed, a confirmation message is
displayed. Click OK to restart Installation Manager. The initial
window opens.

If you click No to cancel this update, you cannot install the
update to the Message Broker Toolkit at this time, because the
update depends on the updated version of Installation Manager.

6. When Installation Manager restarts, click File > Preferences.

7. Click Add Repository, then click Browse and navigate to the
directory in which you extracted the Message Broker Toolkit
update package. Select the file respository.config and click OK.

8. Check that Search service repositories during installation and
updates is selected, then click OK.

9. Click Update Packages. Installation Manager automatically finds
the update for Message Broker Toolkit V6.1.0.2. Follow the
prompts to install the updated component.

10. When you have completed all updates, close Installation
Manager.

Physical media and electronic images

The options described in this section do not require the computer to have
access to the Internet.

Refreshing your existing installation
This option replaces the current installation of Installation Manager
and updates the Message Broker Toolkit installation to V6.1.0.2, by
using the physical media (CD or DVD) or the equivalent electronic
images.
1. Close all Rational programs that are running on your computer,
including the Message Broker Toolkit.
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1.

12.

If you are using physical media, insert the DVD or CD Disk 1
into the drive.

Navigate to the root directory of the CD, or to the equivalent
location in the image directory structure.

Locate and start the installation wizard. The name of the wizard
is shown in [“Installation wizard names” on page 82.|When it
starts, the wizard has preselected both Installation Manager and
the Message Broker Toolkit for installation.

Clear the selection for the Message Broker Toolkit and click Next.
The Installation Manager wizard runs and the product is installed
in the directory in which it is found on this computer.

When installation is complete, close the installation wizard and
start Installation Manager as described earlier in this section. You
can now apply the upgrade to the Message Broker Toolkit.

Click File > Preferences.

On the Preferences window, click Repositories, then click Add
Repository. Click Browse and navigate to the root directory of
disk 1, or the equivalent location in the image directory structure.

Select the file diskTag.inf and click OK.

. Select Search service repositories during installation and

updates and click OK.

Click Update Packages. Installation Manager automatically finds
the update for Message Broker Toolkit V6.1.0.2. Follow the
prompts to install the updates.

When you have completed all updates, close Installation
Manager.

Installing Message Broker Toolkit V6.1.0.2 in a different package group

Installation Guide

If you are installing Message Broker Toolkit V6.1.0.2 on a computer on
which it already installed, but in a different package group, you must
first ensure that Installation Manager is installed at Version 1.1.1 on
this computer:

1.

2.

Close all Rational programs that are running on your computer,
including the Message Broker Toolkit.

Start the Installation Manager installation wizard and follow the
instructions provided to refresh the component (in the section that
immediately precedes this section).

If Installation Manager is already at V1.1.1, the wizard starts
Installation Manager and the Install Packages window opens. The
Message Broker Toolkit V6.1.0.2 package is displayed and
preselected. A status message is also displayed; click Continue to
install into another package group.
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3. Click Next; the License Agreement window opens. Accept the
license and click Next.

4. Specify the package group into which you want to install Message
Broker Toolkit V6.1.0.2. You cannot choose the package group in
which you have already installed Message Broker Toolkit at any
version. Select an alternative package group, or select Create a
new package group and type a new name or click Browse to find
the required location.

5. Click Next; the Language Selection window opens. From this
point, the installation works in the same way as a new installation;
refer to the instructions in [“Installing from CD or DVD” on pagel
starting at step 6, if you need further information.

6. When the installation is complete, click Finish to close the wizard.

Installing Message Broker Toolkit V6.1.0.2 on a different computer
If you are installing Message Broker Toolkit V6.1.0.2 on a different
computer, not as an update to an earlier V6.1 version, follow the
instructions in [“Installing from CD or DVD” on page 104 The media
and electronic images provided for V6.1.0.2 include the latest level of
both Installation Manager and Message Broker Toolkit, and no
additional steps are required.

Dealing with problems during installation

If you have problems during installation:

* Refer to the readme file readme.html for any late changes to the installation
instructions.

* Check the contents of the installation log file YYYYMMDD_TIME.xm1, where
YYYYMMDD_TIME is the date and time of installation. The file is stored in
the directory /var/ibm/InstallationManager/logs on Linux or
%ALLUSERSPROFILE%\Application Data\IBM\Installation Manager\logs on
Windows (%ALLUSERSPROFILE% is the environment variable that defines the
working directory; the default value is C:\Documents and Settings\A11l
Users but this setting might have a different value on your computer.)

+ Review the problem scenarios described in|Appendix A, “Installation|
[problems,” on page 137|and follow the guidance given.

If you are still unable to resolve the problem, contact your IBM Support
Center.
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Part 4. After installation

This part of the book describes what to do after installation:
Verify your installation on Linux (x86 platform) or Windows

You can perform verification on Linux (x86 platform) or Windows
computers only, because it exploits wizards and sample programs
which are available when you launch the Message Broker Toolkit. The
samples require that all WebSphere Message Broker components are
installed on the same computer. No specific verification programs are
provided on other operating systems.

Follow the procedures described in|Chapter 11, “Configuring and|
(verifying your system,” on page 119]

Learn about the product

Information about the product is available in the information center,
which is installed as an integral part of the Message Broker Toolkit on
Linux (x86 platform) and Windows.

After you have installed the Message Broker Toolkit, explore the
Welcome page resources and the information center. These resources
are provided to help you to learn about the product, and how to use
it on all operating systems.

(Chapter 12, “What's next,” on page 127] provides information about
what resources are available and how you can access them.

Develop and unit test domain configurations and resources
After you have purchased a license for WebSphere Message Broker, all
developers in your organization can install one copy of all
components on their own test computer to develop and unit test
components and business resources. This option applies only to
computers that are running Linux (x86 platform) or Windows, because
you must install the Message Broker Toolkit to complete unit testing.
You can also install the supplied WebSphere MQ and DB2 products
on your test computers for use with WebSphere Message Broker only.

Check the broker operation mode

When you have completed installation, verification, and testing, you
might need to change the operation mode of your brokers.

[Chapter 13, “Checking the broker operation mode,” on page 131|
describes when and how to make this change.
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Chapter 11. Configuring and verifying your system

This chapter describes how to verify your installation on Linux (x86 platform)
or Windows. You must install all runtime components and the Message
Broker Toolkit on a single computer to complete these verification procedures.
You must also install a database product for use by the broker.

After verification, you can keep all the components to carry out further
development and unit test. Development and test environments are restricted
to Linux (x86 platform) and Windows systems on which one copy of each
component is installed on each computer. You can also create additional
components and resources on your test computers to investigate the ways in
which your business requirements can be met by this product.

If you have purchased WebSphere Message Broker Remote Adapter
Deployment or Starter Edition, you must modify the operation mode of the
broker after you have completed the procedures in this chapter (unless you
are running a test environment). The broker operation mode is always set to
the default enterprise when you install the broker component from the full
product runtime packages. If you intend to keep and use the default broker
that you create in this chapter, you are required to modify its mode to
conform to the terms of your license. See [Chapter 13, “Checking the broker|
loperation mode,” on page 131 for details of this task.

Getting started

When you have completed installation:
1. Launch the Message Broker Toolkit:

* On Linux (x86 platform), you do not need root authority to complete
verification. You cannot launch the Message Broker Toolkit from the
installation wizard; if you create resources such as brokers when you are
logged in as root, you might experience problems during operation and
this option is therefore unavailable.

Log off from the user ID with which you have installed the product.
Log in as the same ID (if this is not root), or log in as another ID, but
do not become root.

Launch the Message Broker Toolkit from the main menu, or issue the
following command on a command line. The command is located in the
root directory of the package group; either navigate to that directory
before you enter the command, or specify a fully qualified path.

./eclipse -product com.ibm.etools.msghroker.tooling.ide
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2.

* On Windows, you cannot complete verification unless you have
Administrator authority; carry out verification with the same user 1D
that you used to complete installation.

If you did not launch the Message Broker Toolkit from the installation
wizard, launch it from the Start menu, or issue the following command
on a command line. The command is located in the root directory of the
package group; either navigate to that directory before you enter the
command, or specify a fully qualified path.

eclipse.exe -product com.ibm.etools.msgbroker.tooling.ide

When you first launch the Message Broker Toolkit, you are asked to
specify the location of your workspace. This directory exists on your local
drive, and is where the Message Broker Toolkit stores all the resources that
you create. You can accept the default directory shown, or you can specify
your own choice either by typing it in, or by clicking Browse to specify
the location. Select Use this as the default and do not ask again to inhibit
the display of the workspace dialog next time you launch the Message
Broker Toolkit.

The Message Broker Toolkit opens and the Welcome page is displayed.
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Get Started Samples Returning Users Web Resources
Get started with Explore WebSphere Discover new features and  View the latest information
WebSphere Message Message Broker sample learn how to migrate to updates and discover
Broker, create the Default applications WebSphere Message additional web resources
Configuration, then verify Broker Version 6.1
your installation using the
Pager samples

Figure 1. The Welcome page choices (Windows)

3.

Click the Get Started icon Q to begin the configuration and
verification process.

The Get Started page opens, from which you can start the Quick Tour (see
[Chapter 12, “What’s next,” on page 127) or create a default configuration
that is used by a sample program to verify that your installation is
successful. To continue configuration and verification, follow the
instructions in [“Creating the default configuration” on page 121|and
[‘Running the Pager samples” on page 124/
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Creating the default configuration

Before you can run any sample programs, create a set of components within a
broker domain. You can complete this task by using the Default Configuration
wizard, which creates the components that you need with fixed names and
properties.

The Default Configuration wizard requires that the following conditions are
met:

You have installed all runtime components and the Message Broker Toolkit.
On Linux (x86 platform), you have installed DB2 Enterprise Server, and you
have run the DB2 profile for your current user ID, for example:

. ~db2inst1/sql11ib/db2profile

where db2instl is the user ID of the DB2 instance owner (db2inst] is the
default name; substitute the name that is in use on this system).

On Windows, you have installed either the ODBC Drivers for Apache
Derby, or DB2 Enterprise Server.

If you have installed DB2 Enterprise Server Version 9.1 supplied with either
Linux (x86 platform) or Windows, you have registered your license; this
task is described in|Appendix B, “Registering your DB2 license,” on page]

None of the default components already exist (the components are listed in
ITable 16 on page 123b.

This configuration is required for test and evaluation purposes only.

Your current user ID has the following characteristics:

— It is a member of groups mgbrkrs and mgm.

— It has Administrator authority (Windows only).

— Itis alocal ID, not a domain ID (Windows only).

— It is authorized to create a database for the broker:

- On Linux, add your user ID to the DB2 instance manager owner

group.
On some Linux systems, you might also need to add your user ID to
the DB2 administrator group.

- On Windows, add your user ID to the DB2 administrator group.

For more information about these security requirements, see
kecurity” on page 57

You cannot complete the configuration and verification described here if these
conditions are not met.
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To create the default components within a broker domain:

1.

On the Get Started page, click the link to Create the Default
Configuration b
opens.

Click Start the Default Configuration wizard. The Default Configuration
wizard starts.

. The "Creating the Default Configuration” page

Follow the guidance provided by the wizard to navigate through its pages.

The wizard creates a default configuration that can be used by a sample
program to verify that your installation is successful. (Ignore the option to
enable a publish/subscribe broker within the domain. Publish/subscribe
enablement is not required by the sample that you run to verify your
installation. After verification, refer to the information center to find out
about publish/subscribe.)

The wizard displays a progress bar that shows which task it is currently
performing. It also reports on all the actions that it takes by writing
progress information into a scrollable text window from which you can
copy and paste some or all of the information displayed.

The information in the text window is also written to a log file, the
location of which is shown below. If you have not specified the default
workspace directory, wmbt610 is replaced by your chosen value.

Linux (x86 platform)
user_home_dir/IBM/wmbt610/workspace/.metadata/DefaultConfigurationWizard.log

Windows

user_home_dir\eclipse\workspace\.metadata\DefaultConfigurationWizard.log
If the wizard encounters an error in processing, it informs you of what has
happened and returns any error information, for example a return code
from a command. If you know why the error has occurred from the error
text, and can correct the situation, you can do so now. Return to the error
message display and click Yes to continue the wizard.

If you do not understand the error, and do not know how to fix it, click
No. The wizard rolls back all the actions that it has taken so far, if it can,
so that when it completes, your system is in the same state as it was in
before you started the wizard. The text window shows you exactly what
the wizard has, and has not, done.

Click Open Log File to access the log from the summary page of the
wizard; this option is available whether the wizard has succeeded or
failed.
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The wizard creates the resources shown in|Table 16

Table 16. Resources created by the Default Configuration wizard

Name

Type

DEFBKD61

Broker database

Local_Domain

Broker domain

LocalProject

Server project

WBRK61_DEFAULT_CONFIGURATION_MANAGER

Configuration Manager that manages the
broker domain

WBRK61_DEFAULT_BROKER

Broker

WBRK61_DEFAULT_QUEUE_MANAGER

WebSphere MQ queue manager that hosts the
broker and Configuration Manager. The queue
manager has a listener at the first available port
greater than or equal to 2414.

It also starts the Configuration Manager and the broker so that they are

ready to process a sample.

4. On the final page, ignore the option to start the Samples Preparation
wizard; you will start this wizard later in these instructions.

5. Click Finish to close the wizard.
When the wizard completes, it opens the broker topology editor in your
workbench. The editor opens in the Broker Administration perspective and

displays the resources that the wizard has created. The Domains and
Navigator panes within the perspective also show the resources.

You can use the configuration that is created by the Default Configuration
wizard for other purposes. For example, you can import, deploy and run the
supplied samples, or you can create and deploy your own message flows. You
can also run the wizard to remove all the default resources. To start the
Default Configuration wizard from the Message Broker Toolkit, click File >
New > Other > Broker Administration - Get Started.
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Running the Pager samples

To verify your installation, return to the Get Started page. If you cannot see
this page in your workbench, click Help > Welcome to return to the Welcome
page, and click Get Started again.

01010}
1. Click the link to Run the Pager samples M.

The Samples Gallery opens in a separate window and displays the "Pager
samples” page, which presents the following options:

* Set up the Pager samples
This option starts the Samples Preparation wizard, which helps you to
import the samples into your workspace, and to deploy the samples and
associated resources (for example, message flows) to the default broker.
* Run the Pager samples

This option opens the help page with a description of each of three
sample programs, and icons that you can click to start each one.

* Find out what the Pager samples do

This option opens a page that describes in detail what the Pager
samples do and how they work. You can examine the message flows
that implement their function and the messages that are handled by
those flows.

2. Click Set up the Pager samples. The Samples Preparation wizard starts
and displays its first page. The option to import and deploy to the default
broker is preselected.

3. Click Next and follow the guidance provided by the wizard to navigate
through its pages.

The wizard displays a progress bar that shows which task it is currently
performing. It also reports on all the actions that it takes by writing
progress information into a scrollable text window.
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You can copy and paste some or all of the information in this text window.
This information is also written to the following log file:

Linux (x86 platform)

user_home_dir/IBM/wmbt610/workspace/.metadata/samplePreparationWizard.log

Windows

user_home_dir\eclipse\workspace\.metadata\samplePreparationWizard.log
If the wizard encounters an error in processing, it informs you of what has
happened and returns any error information, for example a return code
from a command. If you know why the error has occurred from the error
text, and can correct the situation, you can do so now. Return to the error
message display and click Yes to continue the wizard.

If you do not understand the error, and do not know how to fix it, click
No. The wizard rolls back all the actions that it has taken so far, if it can,
so that when it completes, your system is in the same state as it was in
before you started the wizard. The text window shows you exactly what
the wizard has, and has not, done.

The wizard displays information messages to show that the Pager samples
and associated resources are deployed and ready to run.

Click Next when you have read the messages about the actions completed
by the wizard. The confirmation page is displayed.

Click Finish to close the wizard. The "Pager samples” page (from which
you launched the wizard) is redisplayed.

Click Run the Pager samples. A help page opens and displays two
sections:

* Running the Text Messenger sample (point-to-point messaging)

The Text Messenger sample briefly introduces you to the point-to-point
style of messaging, and demonstrates how message transformation
works. Click the Pager icon to launch the Pager application; click the
Text Messenger icon to start that application and send messages to the
Pager application.

You can start these applications in either order; because they use
WebSphere MQ to pass messages between applications, messages can be
held safely for an application and can be retrieved by that application
when it starts.

* Running the SurfWatch sample (publish/subscribe messaging)

The SurfWatch sample briefly introduces you to the publish/subscribe
style of messaging, and demonstrates how message transformation
works. Click Surf Report Publisher and Pager to start the publisher
application and the Pager application.
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Click Start in the Surf Report Publisher window to start sending
messages about weather conditions at certain surfing locations to the
Pager application. Pager displays all messages that it receives in its
window.

Click Subscriptions. The Surf Report Subscriptions dialog opens. Here
you can select the locations for which you want to receive surf reports;
the messages sent to Pager are controlled by this dialog.

Refer to the help pages to read and understand more about how these
applications work together.

7. When you have sent and received messages successfully, you have verified
that your installation is complete. You can now close your Pager
applications.

You can start the Samples Preparation wizard to create the resources and start
other supplied sample programs. Click File > New > Other > Broker
Administration - Get Started in the Message Broker Toolkit and select
Preparing the Samples. The Samples Preparation wizard opens and lists other
samples that are available. You can also access the Samples Gallery from the
information center.

You can also invoke the Samples Preparation wizard to remove the sample or

samples from the broker, and to remove the sample resources from your
workspace.
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When you have completed installation, there are two main sources of
information that you can use to help you learn about the product, and to
create and deploy a broker domain on all operating systems. Launch the
Message Broker Toolkit to access these resources:

The Welcome page
The Welcome page is typically what you see when you first launch
the Message Broker Toolkit. You can also access it at any time; click
Help > Welcome to display this page. Minimize the Welcome page to
view it alongside other open panes in the toolkit; close it when you
no longer want it in view.

The Welcome page has been designed to ensure that both new and
experienced users can find what they need when they have completed
the installation process. It also has information that is relevant if you
are migrating from previous versions.

In addition to Getting Started (covered in [Chapter 11, “Configuring|
land verifying your system,” on page 119), the Welcome page displays
these choices for you to explore:

* If you are new to WebSphere Message Broker, click the Get Started

icon Q to learn about the product.

Access the Quick Tour, which provides new users with an overview
of key product concepts, and shows its main interfaces in a
graphical format. The tour lasts approximately 15 minutes.

* If you have a previous version installed, click the Returning Users

icon <> to see what new and enhanced functions are included
in Version 6.1. From here you can also access a description of the
steps that you need to take to migrate your current broker domain
to Version 6.1. The information provided covers planning,
preparation, and implementation.

(l@
* Click the Samples icon & to explore samples that show how to
exploit the function of the broker.

The Samples Gallery includes samples that show how you can
develop message flows and message sets that exploit the message
routing and transformation capabilities of the broker.
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* Click the Web Resources @ icon to link to additional resources
on the Web that support WebSphere Message Broker. These include
education courses, Business Partners, and IBM support.

The information center

Installation Guide

The information center provides full post-installation documentation
for the product on all operating systems. Click Help > Help Contents
in the Message Broker Toolkit to open the information center in a new
window. The front page links to topic pages within the information
center and to other resources such as IBM Redbooks. You can also
read about different ways to find information in the information
center, whether you are a new user or an experienced user.

The information center is divided into sections that cover tasks and
reference information. The task sections listed below are those that
you might typically want to explore first.

Start here
The Start here section provides new users with information
that introduces the product and what you can do with it. It
provides explanations of the main terminology and
components, and presents a set of initial tasks in an order that
you would typically take as a new user.

Start here topics link to other areas of the information center,
and to external links, to help you to understand more about
the product, and to employ its varied functions to solve your
business problems.

Start here also contains hints and tips for more experienced
users who have installed previous versions.

Configuring the broker domain

The broker domain and its components are explained, and the
tasks that you must complete to create a broker domain and
the resources that it requires on all operating systems are
described.

* Use the appropriate mqsi commands (for example,
mgsicreatebroker). Navigate through the Configuring
section to find details about the tasks involved in creating
your configuration and the commands to use.

When you issue commands on a distributed system, you
must ensure that you issue them in the correct environment
and to the correct installation.
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For the verification process described in Eihapter 11,|
[“Configuring and verifying your system,” on page 119/ the
Default Configuration wizard completes this action for you,
but you must set up the environment yourself if you are
not using the wizard, or if you are working on operating
systems on which the wizard is not available:

Linux and UNIX
Run the mgsiprofile file, supplied in the following
directory:

install_dir/bin

Windows
Click Start > IBM WebSphere Message Brokers 6.1
> Command Console to open a window with the
correct environment setup. Invoke the commands in
this window.

See the topics in the information center under Reference >
Operations > Commands for more details about
mgsiprofile, and how to initialize the environment.

This action is not required on z/OS.

* On Linux (x86 platform) and Windows, use the Default
Configuration wizard to create components of fixed names
on systems local to the toolkit, as explained in |Chapter 11,|
[“Configuring and verifying your system,” on page 119 You
might find this wizard useful even if you do not want to
complete the verification steps.

* On Windows only, use the Command Assistant wizard to
create components with your choice of names and
characteristics. In the Message Broker Toolkit, click File >
New > Other > Broker Administration - Getting Started to
access the Command Assistant wizard. This wizard can also
modify and delete existing components.

Developing applications

This section provides details about how to develop message
flows, message sets, user-defined extensions,
publish/subscribe applications, and more.

Deploying

Find out about broker archive files, configurations, and
topology, and how to deploy the message flows and other
resources that you have developed.
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Chapter 13. Checking the broker operation mode

You must ensure that you configure your production brokers to conform to
the terms of your license.

If you are upgrading from the Trial Edition

If you installed

WebSphere Message Broker Trial Edition, and have

now purchased a license, you can keep the components and all the
associated resources that you have already created and configured.
You do not have to uninstall the Trial Edition and reinstall the
purchased packages. However, if you do not reinstall, the operation
mode of your existing brokers, and the default operation mode of all
new brokers that you create, has the value trial, and you must
change this value:

* If you intend to keep the brokers that you created for your trial
domain for further development and unit test by your developers,

change the o
described in

eration mode of each broker to enterprise, as

‘Changing the broker operation mode” on page 134

After this change, your brokers are no longer restricted by the trial
period, but check the license agreement file to ensure that you
conform to any restrictions for development and unit test.
Development and unit test conditions are described in

[requirements” on page 25

* If you intend to use the brokers that you created for your trial
domain for production purposes, change the operation mode to
conform to the license that you have purchased:

— If you have purchased Remote Adapter Deployment, change the
operation mode to adapter.

— If you have purchased Starter Edition, change the operation
mode to starter.

— If you have purchased the full (unrestricted) license, change the
operation mode to enterprise.
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If you do reinstall the runtime components with the new physical or
electronic packages for your purchased product, the default operation
mode of all new brokers that you create has the value etnerprise. If
you have purchased Starter Edition or Remote Adapter Deployment,
you must always change the mode to confirm to the license that you
have purchased.

If you also installed trial versions of WebSphere MQ, DB2, or both,
you are now entitled to install the restricted license version of those
products that are supplied as part of WebSphere Message Broker. You
do not have to make any further purchases if the supplied products
meet your requirements, and you intend to use them only with
WebSphere Message Broker.

WebSphere MQ

Take the following steps to change from your trial version of
WebSphere MQ:

1. Uninstall the trial version.

2. Install the version of WebSphere MQ that is included with
WebSphere Message Broker by using either the supplied
media or the images that you have downloaded. If you are
installing on Windows, you can use the Launchpad to help
you to install this product.

3. If you prefer, for example if you want to use WebSphere
MQ for applications that are not related to your use of
WebSphere Message Broker, you can purchase a separate
license for WebSphere MQ.

DB2

To change from your trial version of DB2, you must register
your license on every computer on which you have installed
this copy of DB2. This process is described in |Appendix B,l
[‘Registering your DB2 license,” on page 141

You do not have to uninstall the trial version and install the
version of DB2 that is included with WebSphere Message
Broker.

If you to use an alternative supported version of DB2, or you
want to use DB2 for applications that are not related to your
use of WebSphere Message Broker, you must purchase a
separate license for DB2 at that version and install the product
again.

If you already have licensed copies of WebSphere MQ, DB2, or both,
you do not have to take any further action, provided that the licensed
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products that you have installed meet the requirements of WebSphere
Message Broker, shown in [Chapter 1, “System requirements,” on page|

If you have purchased Remote Adapter Deployment or Starter Edition

If you have purchased WebSphere Message Broker Remote Adapter
Deployment or WebSphere Message Broker Starter Edition and
installed components from the full runtime package:

 All brokers that you have created (for example, by completing the
verification procedures) have an operation mode set to enterprise,
which is the default setting for this installation. You can keep these
brokers for further development and unit test, subject to any
restrictions that apply for unit test environments, as indicated in
your license. Development and unit test conditions are described in
[“License requirements” on page 25/

* If you intend to use these brokers for production purposes, follow
the instructions in [“Changing the broker operation mode” on page|
to conform to the license that you have purchased:

— If you have purchased Remote Adapter Deployment, change the
operation mode to adapter.

— If you have purchased Starter Edition, change the operation
mode to starter.

* When you create new brokers, you must set the operation mode to
conform to the license that you have purchased. When you create a
new broker, the operation mode is set to the default value
enterprise. You can either override the default value by specifying
an alternative value of adapter or starter with the -o flag on the
mgsicreatebroker command, or you can change the mode by using
the mqsimode command for the created broker.

If you have purchased a full (unrestricted) license for WebSphere Message

Broker

If you have purchased a full (unrestricted) license and installed
components from the full runtime package, all brokers that you create
have an operation mode set to the default value of enterprise, which
is the correct setting for your license.

Whenever you create a new broker, on existing installations or on
different installations or computers, the operation mode is set to
enterprise, and you never have to change this value.

You can continue to work with all the components and associated
resources that you have already created. For example, after you have
completed verification, you might keep the resources that you have
created for further development and unit test, subject to any
restrictions that apply for unit test environments, as indicated in your
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license. Development and unit test conditions are described in
[“License requirements” on page 25/

For a full description of the broker operation mode, and behavior associated
with each mode, see the information center. If you want to know more about
your license and terms and conditions, see [“License requirements” on page 25
or contact your IBM representative for further information.

Changing the broker operation mode

134

To change the broker operation mode:

1. On Linux (x86 platform), run the mqsiprofile command to initialize the
command environment. On Windows, click Start > Programs > IBM
WebSphere Message Brokers 6.1 > Command Console to open a
command console.

2. Enter the following command:
mgsimode —i ip_address —p port —q queue_manager -b broker —o new_mode

where:

* ip_address is the host name or the IP address of the computer on which
the Configuration Manager is started. You can omit this parameter if
you have created the broker and Configuration Manager on the same
computer.

* port is the port number on which the Configuration Manager’s queue
manager is listening.
* queue_manager is the name of the queue manager that hosts the

Configuration Manager; for example,
WBRK61_DEFAULT_QUEUE_MANAGER.

* broker is the name of the broker; for example,
WBRK61_DEFAULT_BROKER.

* new_mode is the operation mode that is required for this broker. You can
set the mode to enterprise, adapter, or starter.

For more information, and other examples of the use of this command, see
the information center.
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Appendix A. Installation problems

This appendix describes problem scenarios that you might experience during
component installation on distributed systems. Refer to the Program Directory
for WebSphere Message Broker for z/OS or the Program Directory for WebSphere
Message Broker with Rules and Formatter Extension for z/OS if you experience
problems installing on z/OS.

The installation wizards return zero if installation is successful. If a non-zero
return code is returned, check the installation log files for errors and
explanations:

* Problems associated with installation of the runtime components are
recorded in the log file mqsi6_install.log which is stored in the home
directory associated with your account:

Linux and UNIX
Enter echo $HOME to find your home directory.

Windows Your home directory is typically C:\Documents and
Settings\userID. Enter echo $HOMEPATH% to check the
location.

* Problems associated with installation of the Message Broker Toolkit are
recorded in the Installation Manager log file, YYYYMMDD_TIME.xm1, where
YYYYMMDD_TIME is the date and time of installation. The file is stored in
the directory /var/ibm/InstallationManager/logs on Linux or
%ALLUSERSPROFILE%\Application Data\IBM\Installation Manager\logs on
Windows (%ALLUSERSPROFILE% is the environment variable that defines the
working directory; the default value is C:\Documents and Settings\Al1l
Users but this setting might have a different value on your computer.)

Typical problems, with a solution, or a workaround, are described below:

All operating systems: runtime component installation process is
interrupted
If you are installing runtime components, and the process is
interrupted before completion, for example due to a power failure,
delete the install_dir and all its contents before you restart the
program.

Linux: java.lang.UnsatisfiedLinkError
If you are using the graphical interface to install on Linux, you must
install additional packages for this interface to work correctly. See
[Table 4 on page 9| for details.
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Linux: RPM query fails

If you invoke an RPM (package manager) query after you have
installed the product, and nothing is returned, it is likely that your
system does not have the required RPM support.

An information message similar to the following message might have

been reported in the installation log:

(01-Jun-2005 09:02:27), mgsi.Setup,
com.ibm.wizard.platform.Tinux.LinuxProductServiceImpl, wrn,
The installer could not successfully add the product information
into the RPM database. Installation will continue as this is not
critical to the installation of the product.

Install the additional RPM build package that is described in

Linux and UNIX: display problems

If you try to install one or more runtime components by using the
graphical interface, you might see one of two common errors
reported. These typically occur if you log in remotely, or you switch
user ID.

* Can't open display localhost:1.0

Check that the DISPLAY variable is set to the correct value. If you
are logged in locally, the typical value is :0.0 or Tocalhost:0.0.

e Connection to ":0.0" refused by server
Run the following command, where user is the user you are logged
in as:
xauth merge “user/.Xauthority

If you are unable to correct this error, contact your systems
administrator for further help.

Linux and UNIX: insufficient temporary space
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When you install the product, the installation program tries to unpack
product files into the local system’s temporary file space. On Linux
and UNIX systems, the temporary space is typically /tmp. If there is
not enough file space available in this directory, the command might
fail without reason (the command returns with no comment), or it
might report a lack of file space.

To correct this problem, give the installation wizard (for example,
setupaix) a temporary file system to use. The command-line option is
-is:tempdir name of temp directory.
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For example, on AIX, enter the following command:
./setupaix -is:tempdir /Targetemp

Do not specify a temporary directory that is NFS mounted from
another machine; if you do so, the installation might fail because user
permission checks made by the installer sometimes report an error
that security principals mqm and mqbrkrs do not exist on the local
machine.

See [Table 3 on page 7| to check how much temporary space is
required.

Linux (x86 platform) and Windows: Installation Manager
If you click Next in the Installation Manager immediately when it first
opens, you might cause the Installation Manager to hang. Close the
window and reopen it.

Linux (x86 platform) and Windows: Installation Manager
If you are installing the Message Broker Toolkit, and the initial Install
Packages page that is displayed by Installation Manager does not
show the Message Broker Toolkit components, the location has not
been set correctly.

Select File > Preferences and click Add Preferences. Enter the URL or
directory where the installation packages are stored or click Browse to
search for the correct location.

Click OK. The packages are listed in the Install Packages page.
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Appendix B. Registering your DB2 license

If you have installed DB2 Restricted Enterprise Server Version 9.1 from the
media supplied with WebSphere Message Broker, you must register the
associated license. Complete this task on every computer on which you have
installed DB2 from the WebSphere Message Broker media.

1. Log in to the computer. On Linux and UNIX systems, your user ID must
have root authority. On Windows, you must have Administrator authority.

2. Issue the register command:

AIX systems
/usr/opt/db2_09_01/adm/db21icm -a db2_installation_directory/license/db2ese_o.lic

Linux and other UNIX systems
/opt/IBM/db2/V9.1/adm/db21icm -a db2_installation_directory/1icense/db2ese_o.lic

Windows systems
Open a DB2 command window and enter the following command:

db21icm -a db2 installation_directory\license\db2ese o0.1ic

where db2_installation_directory identifies the directory into which you have
installed DB2 Restricted Enterprise Server Version 9.1.

The DB2 product license key information is now stored in the following
directories:

AIX systems
/var/ifor

Linux and other UNIX systems
/var/Tum

Windows systems
DB2PATH/sq11ib/1icense
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Appendix C. Notices

This information was developed for products and services offered in the
U.S.A. IBM may not offer the products, services, or features discussed in this
information in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any
other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY,
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore
this statement may not apply to you.
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This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England

SO21 2JN.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement or any equivalent
agreement between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.
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Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

IBM The IBM logo AIX
ClearCase DB2 DB2 Connect
DB2 Universal Database developerWorks eserver
Everyplace IBMLink IMS
Informix iSeries 0S/400
Passport Advantage POWER pSeries
RACF Rational Redbooks
SupportPac System i Tivoli
WebSphere xSeries z/0OS

zSeries

Adobe, the Adobe logo, PostScript, and the PostScript logo are either
registered trademarks or trademarks of Adobe Systems Incorporated in the
United States, and/or other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc.
in the United States, other countries, or both.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

Intel and Pentium are trademarks of Intel Corporation in the United States
and other countries.

UNIX is a registered trademark of The Open Group in the United States and
other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Other company, product, or service names may be trademarks or service
marks of others.
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Glossary of terms and abbreviations

This glossary defines WebSphere Message
Broker terms and abbreviations used in this
book. A full product glossary is provided in
the information center. For information
about how to access the information center,
see [“Where to find more information” on|

|Eage xii.|

For information about terms and
abbreviations that are not specific to this
product, see the [[BM Terminology Web site]

B

broker. A set of execution processes that host
one or more message flows. Also known as
message broker.

broker domain. A collection of brokers that
share a common configuration, together with the
Configuration Manager that controls them.

C

collective. A set of brokers that are fully
interconnected and form part of a multi-broker
network for publish/subscribe applications.

Configuration Manager. The component that
provides an interface between the Message
Broker Toolkit and a set of runtime brokers. It
provides brokers with their initial configuration,
and updates them with any subsequent changes.
It maintains the broker domain configuration.

D

deploy. To make operational the configuration
and topology of the broker domain.

Derby. The database product based on the
Apache Derby open source project from the
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Apache Software Foundation. The Derby
database is embedded in the broker component
on Windows only.

E

execution group. A named process or set of
processes within a broker in which message
flows are run. The broker is guaranteed to
enforce some degree of isolation between
message flows in distinct execution groups
because it ensures that they run in separate
address spaces, or as unique processes.

L

local error log. A generic term that refers to the
logs to which WebSphere Message Broker writes
records on the local system. Also known as
system log.

M

message broker. See broker.

Message Broker Toolkit. The integrated
development environment that includes IBM
Rational features and plug-ins, and is based on
the IBM WebSphere Eclipse Platform.

message flow. A sequence of processing steps
that execute in the broker when an input
message is received. A message flow must
include an input node that provides the source of
the messages that are processed. Message flows
are deployed to a broker for execution.

MRM domain. The domain associated with
messages that are modeled in the Message
Brokers Toolkit.
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operation mode. The mode in which a broker
runs that determines what operations it can
perform.

P

point-to-point. A style of messaging application
in which the sending application knows the
destination of the message. Contrast with
publish/subscribe.

principal. An individual user ID (for example, a
login ID) or a group. A group can contain
individual user IDs and other groups, to the
level of nesting supported by the underlying
facility.

publish/subscribe. A style of messaging
application in which the providers of information
(publishers) are de-coupled from the consumers
of that information (subscribers) by using a
broker. See also topic. Contrast with
point-to-point messaging.

publisher. An application that makes
information about a specified topic available to a
broker in a publish/subscribe system.

R

Rational Application Developer (RAD). A
comprehensive integrated development
environment, based on the Eclipse open source
platform, that accelerates application
development and deployment.

S

subscriber. An application that requests
information about a specified topic from a
publish/subscribe broker.

system log. See local error log.
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T

topology. The brokers and collectives (and
connections between them) in the broker domain.

Transformation Services. Message
transformation and routing services that extend
the capability of the broker.

U

User Name Server. A component that interfaces
with operating system facilities to determine
valid users and groups.

w

workbench. An active instance of the Message
Broker Toolkit that is associated with a user’s
workspace. The workbench might also include
plug-ins from other products that have been
integrated with the base plug-ins of WebSphere
Message Broker.

workspace. A store of resources accessed by the
Message Broker Toolkit, typically associated with
a user or set of users.
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problems, Message Broker
Toolkit 115
problems, runtime
components 101
runtime components 97
silent interface 101
mgqsiprofile 129
package manager (RPM) 10

locales 38

installing for Message Broker
Toolkit 108

memory requirements 5
Message Broker Toolkit

coexistence
Message Brokers Toolkit
Version 5.0, 5.1 32
Message Brokers Toolkit
Version 6.0 32
restrictions 31
description 73
disk space requirements 6
display resolution 5
hardware requirements 4
installing 103
CD on Linux (x86
platform) 105
graphical interface 105
problems 115
silent interface 108
locales feature 107
memory requirements 5
package group 106
shared resources directory 106
software license agreement 106
workspace 120

Message Broker Toolkit CDs

making copies 109

Message Broker Toolkit packages

contents 49

migration
from previous versions 34
reverting to previous level 29
mgsimode command 134
mgsiprofile 32

N

national language support 37

(0

ODBC Dirivers for Apache
Derby 12
operating systems requirements 9
operation mode
changing after trial 134
optional software 24
Oracle, supported products 14

P

package contents
DVDs 51
runtime components 45
package group 22
Pager samples
removing 126
running 125
setting up 124
Surfwatch 125
Text Messenger 125
Passport Advantage 62
download packages 41
preparing your system
accessing CDs and DVDs 62
kernel parameters 69
security 57
product requirements Web site 4
publications  xiii

Q

Quick Start CD  xii, 43, 50
Quick Start Guide 44
Quick Tour

overview 127

software requirements 25

R

RACF 61
RAD
See Rational Application
Developer
Rational Application Developer 21
Rational products 21
Rational Software Architect 21
readme file 3
Redbooks xiv
Remote Adapter Deployment 25



removing product components X
requirements
additional software 19
communications 8
databases 12
disk space 6
hardware 4
licensing 25
memory 5
operating systems 9
software 9
response files 77
RSA
See Rational Software Architect
Rules and Formatter Extension
installation ix
package contents 53
runtime components
coexistence
distributed systems 27
restrictions 29
z/0S 30
custom installation 28
description 71
disk space requirements 6
installation problems 101
memory requirements 5
typical installation 27
runtime packages
contents 45

S

Samples Gallery 127
security
for installation 58
for verification 121
Linux and UNIX systems 58
principals 57
user ID restrictions 58
Windows 60
domain environment 61
z/OS 61
service
runtime updates to V6.1.0.2 35
toolkit updates to V6.1.0.2 110
shared resources directory 21
silent installation
generating response file
template 79
recording response file 79
running with response file 80
software license agreement 91, 99
software requirements
32-bit and 64-bit operation 11
additional products 19

software requirements (continued)
databases 12
operating systems 9
optional software 24
Solaris
installing
console interface 100
graphical interface 99
problems 101
runtime components 97
silent interface 101
mgsiprofile 129
SQL Server, supported products 14
Starter Edition 25
support Web site 3
Sybase, supported products 14

T

temporary space
problems 138
requirements 6
Terminal Services, Windows 60
terms used in this book x
Tivoli License Manager 24
Trial Edition 25
changing operation mode after
purchase 134
Launchpad 87
package contents 42
trial version
DB2 132
WebSphere MQ 132
typical installation, runtime
components 27

U

uninstalling product components x
UNIX x
UNIX kernel parameters 69
upgrading

from previous versions 35
upgrading runtime components 97
User Name Server 72

\'}

verifying your system 119, 124

verifying your system getting
started 119

version and release 28

w

WebSphere Adapters 24
WebSphere Information
Integrator 18
WebSphere Integration
Developer 21

WebSphere MQ
requirement 19
WebSphere MQ Everyplace 24
what to install 71
WID
See WebSphere Integration
Developer
Windows x
command console 129
installing
console interface 100
graphical interface 99
Message Broker Toolkit 103
problems, Launchpad 94
problems, Message Broker
Toolkit 115
problems, runtime
components 101
runtime components 97
silent interface 101
Launchpad
Advanced Installation 92
Express Installation 89
Terminal Services 60
UNC paths 62
working directory xi, 29
workspace 120

X

XML Toolkit 23

V4

z/0OS x

Index 151



152 Installation Guide



Sending your comments to IBM

If you especially like or dislike anything about this book, please use one of
the methods listed below to send your comments to IBM.

Feel free to comment on what you regard as specific errors or omissions, and
on the accuracy, organization, subject matter, or completeness of this book.

Please limit your comments to the information in this book and the way in
which the information is presented.

To make comments about the functions of IBM products or systems, talk to
your IBM representative or to your IBM authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use
or distribute your comments in any way it believes appropriate, without
incurring any obligation to you.

You can send your comments to IBM in any of the following ways:
* By mail, to this address:

User Technologies Department (MP(095)

IBM United Kingdom Laboratories

Hursley Park

WINCHESTER,

Hampshire

SO21 2JN

United Kingdom

* By fax:
— From outside the U.K,, after your international access code use
44-1962-816151
— From within the U.K., use 01962-816151
* Electronically, use the appropriate network ID:
— IBM Mail Exchange: GBIBM2Q9 at IBMMAIL

- IBMLink : HURSLEY(IDRCF)
— Internet: idrcf@hursley.ibm.com

Whichever method you use, ensure that you include:

* The publication title and order number

* The topic to which your comment applies

* Your name and address/telephone number/fax number/network ID.
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